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Introduction

The entertainment industry relies on
the narrative pull and believability of

a character, and that character starts
its life in the hands of a concept artist,
With a need for powerful and flexible
tools to create these unique and refined
character designs, the popular method
of choice among concept artists in the
industry is digital p g in P

important part of character design, holding
the power to dramatically change the mood,
narrative, and those all-imporiant elements
thal make a character recognizable.

To guide you through your creative learning,
we have gathered a selection of skilled,
professional digital artists to lead you through

Offering not only the advantages of
ease and speed, but also the ability to
dramatically alter the colors of your
image and use custom brushes to
create impressive and credible textures,
it really is an extraordinary outlet in
which to hone your creative skill set,

Browsing through the most impressive 2D
character concepts online, as well as in
books. films, and games. you will find a vast
variety of designs in many different styles.
So how dao you begin to find the right style
for you and put your ideas into practice?
Figuring oul the way your characters will
look and act is definitely not an easy task
Shapes. colors, textures, and values are an

the fund tals behind digitally painting
characters. At the back of the book you'll find
an invaluable glossary written by the brilliant
Bram "Boco” Sels, covering all the essentials
to get you started — plus you can refer back
lo it while reading through the more detailed
project overviews that the book has to offer.

From setting up your interface and tools
with characters in mind. to in-depth crealive
workflows packed full with top tips and
advice, Beginner’s Guide to Digital Painting
in Photoshop: Characiers provides a
definitive resource for anyone an the path
o becoming a digital character artist.

Jess Serjent-Tipping
Deputy Editor, 3dtotal Publishing
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Getting started

Find out how to successfully set up your
workspace and functions in Photoshop.

Learning how to use Pholoshop for characler design can be
daunting. To get you setup and ready to start painting, Benita
Winckler will guide you through the features, tools, and useful
functions that will become a staple in your workflow. In this section,
Benita will give a breakdown on setling up your canvas and

layers ready for painting. overcoming a blank canvas, creating
your own brush library, and defining your color palette, all of

which will provide a solid foundation for the tutorials to come!




Setting up your canvas

How to prepare your workspace to start painting characters

by Benita Winckler

In this introductory chapter we will a bit of creative madness (very useful!)
look at Photoshop CC and how to use

it for character design. If you are a You will learn how to:

traditional artist (beginner-level or with

some experience), but you have never set up your canvas

really worked with the software before

- perfect! You are in the right place. set up your layers for painting

Before we begin, let me say right away * create your own brush library
Photoshop is a massive program.

On first sight it can be a real beast define your color palette

(although a nice one). Mastering all of
its powerful features up to the very last
button will not happen overnight. We
are in here for results though, right?

We'll start with a character that has
already been developed and use it as

an example to set up our document for
the actual painting process. The next
steps will give you a solid overview and
foundation for the tutorials that will follow

in this book. Here is what you'll need:
* basic knowledge of drawing traditionally
* Photoshop CC - if you have an older
version, say CS5, that will work as
well, it's just that the example imaaes

here might look a bit different for you

* a good graphics tablet, preferably one

with a high range of pressure sensitivity;

A This is how the inlerface of Pholoshop will look, with the workspace sel lo default Ess 15 D2a

but for now simply use what you have



A Keep the Essentials workspace, so that we all look at the same panels. If needed, select
Reset Essenlials

ayers panel in

all the tim

accordingly)

s of users
ats for worksp: 3 | Step 03

PS i ot mage lme Type Seert e 3D View Wedow Hep  Application bar (Menu bar)
SRR L b Traratorn Cortas. ] B2 =2 [® 08 b

*4 | Tool bar

{currently selected: the Move tool) Secondary panel column

Panel column with tabbed panel groups

Panel menu icon

A Looking at the interface. The Oplions bar shows the options for the currently selected tool, in this case, the Move tool 03a



View  Windo Help

Workspace

Alt+F2

Character
Character Styles
Clene Source
Color

Histogram

History
Infe
Layer Comps

Measurement Log
Navigator

Notes

Paragraph
Paragraph Styles
Paths

Properties

Styles

Swatches
Timeline

Tool Presets

4 Opening a new panel 1o be included.
Note that open panels are ticked

If you want to open the Brush panel, simply
> Brush (image 03b) and
the panel will attach its icon to the column

go to Window

as you can see in image 03c. If thereis a
check mark next to the option it means the
panel is already open in the panel column
tabs, Click the arrows to minimize and
click the panel icon to loggle hide/show
(image 03c). To close the Brush group
panel, click Close Tab Group (image 03d)

Step 04

Canvas resolution - print or scre

Depending on your needs, you will either

want to create a file for screen purposes or

Toggl

Minimize

EERRERERERBEER

4 Click the arrow icon to minimize a panal

Taxture

Dusl Brush
Dynamics

Transher

Brush Pase

Buid-vp

Smoothing

Protect Texture

4 Closing the Brush panel/panel group

for printing. At the start of a project you might
not always know if you'll need a print version
later on or not. Keep in mind that if you
create and polish your character in screen
resolution (72 dpi), you will not be able to
print it in high quality later on (image D4a)
High-resolution print documents {300 dpi)
however, can be converted into screen or
web resolution easily without loss of quality.

Let's create a screen-resolution file ('l

explain the print preset as well, so you can
decide on the output resolution you prefer
for your artwork). In the top menu bar click

File > New, then in the dialog box, select

03¢

Reset All Locked Settings

;C"c‘:: N
Gl

03d

Preset: Web and assign a name (or do

s0 when saving your file). We will create

a standing character, so we need portrait
dimensions. Aller the default values to 600
pixels for width and 800 pixels for height
The Preset changes to custom, indicating
custom-sized dimensions. Leave the other

entries untouched and click OK (image 04db).

For print resolution, select Preset:
International Paper, which gives you an A4-

sized document at 300 dpi (image 04c). Your

v document will appear. Click File > Save

As: keep the defaull file format of PSD. Use

the Zoom tool (Z) to navigate (image 04d)



PS Fie Edit Image layer Type Sels

5 Q- qa T Resize Windows to At
Frr_—sc—[: rirst_character @ 100% (RGB/8)

-.*;mt Puxels :
Heigh @ Pixels :
Resolutio ° Pixels/Inch :

Color Mode: | RGB Color  #| | B bit =
Background Contents: = White s Image Size:
1,37M
Advanced
Color Profile: = sRGB 1EC51966-2.1 =

Pixel Aspect Ratio:  Square Pixels =

A& Web/screen settings Im

Name:  Untitie

Intemnational Paper = Cancel

APENTRN Aeryb

Size: A4 B
Width: 210 = *

Height: 257 Millimeters 2

Besolution: | 300 Pixels/Inch 3

Color Mode: | RGB Color = B bit b

A Your new document (size 600 = 800
& Print settings |m pixels) at 100%. Try using the Zoom tool (Z)

un



Image §

Image Size

Dimensions

Fit To

.-.udm Pixels s
@He\thO Pixels %

Resolution: 72 Pixels/Inch :

~ Resample:  Automatic =

lﬂ
P = == p——

i Confirm

& Transform the sketch layer (Ctr+T)

4 Enlarging the scanned image. To maintain proportions, held down Shift while dragging the anchar points, or activate the chain icon



4 - F
m_characier p @ SO (Canp Prrwr, BCI/E ¢

A Cropping or extending your canvas

Step 06

How to copy/p:

one docum

The ¢

n your canvas. Hi

1sform tool and click

nts to and

"For a very intuitive way to
resize your canvas, simply
use the Crop tool. You'll
love it"

Step 07

t e canvas dimensi

OUr canvas is por

acter, thisis a
to change

ainting

de that we nee

of our character

space 1o the

and les:

the
olay th

es on the ca each fi

aring a vari

o7

love it — it can be used for

as extend

is C), mark

area for your canvas with Arquee

selection (the box that a ars when

ou drag the Crof

OVEr your canvas

marking out the are;

you confirm 1o cre
points al




in the Edit menu or in {
The solution: for
regularly

and

of h,

% PRO TIP

Enjoy the swiftness of Actions
Actions are a god-send. You need
them. You can see some of my
favorite actions | have assigned F
kays to in the image to the nght.You
can also asign keyboard shortcuts by
clicking on Edit > Keyboard Shortcuts
where you can alter how you access
most Photoshop tools. Shortcuts |
find myself constantly using are:

* Ciri+Alt+Z to undo

* Ctri+Shift+] to invert the selection
« Ciri+S to save (it's a lifesaver)

+ B and E to altemnate between

LR T T T T S S O T T G

by heart e the the Brush tool and the Eraser.

simy

Okay. h i = A Record your Actions a llect them in sets, or set up keyboard shortcuts to speed up your workflow

Actions panel menu

History  Actions

+ B v @@ Defaul Actions
1 New Set v a P Vignefiz (sclection)
|| Frame Channel - 50 ...
‘Wood Frama - 50 pi...
Cast Shadaw (type)
Water Reflection (ty...
‘Custom RGE to Gra...
Malten Lead
Make Clip Path (sele...
Sepia Toning {leyer)
Quadrant Colars
Save as Photoshop ..
Gradient Map

2 New Action
3 Start Recording of Action

4 Stop Recording of Action

L T T O S T U T S S
Y Y Y Y Y YYTYYYYY

Mew Set = -
. Adjustments  Styles
Name Akl o et
206 ik BE P1 Y
EHA2ESOHE

d [ X (1




Mew Action

Color:

F2
e 3
F4
£5
F&
F7
F8
Fo
F10
F11
F12

& The New Action dialog pop-up

Click here to stop

A The icon to stop recording

Function Key: | None *=

Name:  Action 1

Set:  Benita's favourites : Cancel

-

+—— Assign a short key for the Action

Actions
v E ¥ W Lmaun muars

v B p Vignette (selection)

= Frame Channel - 50 pixel
Wood Frame - 50 pixel
Cast Shadow (type)
Water Reflection (type)
Custom RGB to Grayscake
Molten Lead

Make Clip Path (selection)
Sepia Toning (layer)
Quadrant Colars

Save as Photoshep PDF

]
YyYYYYTYYYYTYTYYY

Indexed colors to normal
Merge layer
Action 1

4 vy vy vy v vy vvwy

v
4
v
v
b
'
d
v
v
v
v
v
4
4
v
v
+
v
<
e
+
e

Now we are recording

08c

have lo create those Actions and you will
have to learn the buttons you assign to

them. But create once, enjoy forever!

You can create Actions for your favorite
tasks such as Flip Canvas (very useful to
check the balance of your composition with
the push of a button), Flip Layer, Rotate
Layer, Merge Layer (needed all the time),
and Rotate Canvas. Assigning them to
Function keys (F4, F5, F6, and so on)
means they are comfortable to reach.

To get some practice, let’s create
a simple Action for ourselves. You

will see that it's fast and easy.

Say we want lo create an Action for flipping
the canvas. From the top menu bar,

select Window = Actions, and a panel will
open up showing a default set of Actions
called Default Actions. We could add our
new Actions to this default set, but it is

more organized to have our own set

Click the folder icon (see 1 in image 08a)

to create a new set (this will hold our new
Actions) and name it. Now we are ready to
create an Action in our new sel. To creale
the Action, click on the small page icon (see
2 in image 08a) or select New Action from
the Actions panel menu. A panel will pop up;
name the action “Flip canvas horizontal
Assign a function key thal you would like

to use for this command (you can always
alter the Action later) and hil Record (image
08b). The dialog box will close and a little
red dot in the Action panel will indicate

that we are recording (image 08c)

Now do exactly the steps that you want to
record. For example, from the top menu bar
select Edit » Transform > Flip Horizontal
(the image will be flipped). Next hit the
stop symbaol in the Aclions panel to stop
recording (image 08c). That's it! If you
accidentally recorded some other steps
with it, you can delete the Action and start
again fresh, To delete an Action click the
small trash bin icon or de so via the Actions
panel menu. To play your new aclion
simply, hit the function key you assigned



Overcoming a blank canvas

How to generate ideas and take them to the next step

by Benita Winckler

We now have a basic understanding

about the workspace and feel comfortable

: liva e drove |l o pant
about handling our canvas. We have
also gained knowledge about how a r
to copy and paste content between S{ rau\‘b& " W & w'(t( e P ~
files (we will need this soon). Won' + 7 L Ea
e

- ‘I e
In this chapter, let's do a bit of time \~:) (}7 p

traveling and go right back to the

starting point of any character design! i ’I"I""i; /' Ebf cat ey ""A__

“Some projects will ri dr M R l ¢male
demand a highly polished ¢ (v A0

result, while for other i 3 P
projects a number of rough i
sketches will be sufficient”

4 e -\YW‘J‘

“ -1-] J
Step 01

What does the client need?

What do we need in the beginning? A

are working as a character

L they will give us

riptions along with

or the preferred style of

'We will also be given

fitional information such as whether

the ill be used as reference for a

on. The more infarmation

1 this stage, the better |
£ |

A\ wode. n
H‘:g, ! & che eg

Depending on the general purpose of your

Hllustration, some projects will demand a

ghly polished result, while for other projects
» number of rough sketches will be sufficient, 4 An early concept [ 01

20
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»

& An example of a mood board to refer to when selecting elements Im

for your character design

Anather factor to consider is how lo
communicate your vision and ideas
effectively. Conveying moods and feelings
rather than technical ideas, for example, is

better done in color (we will discuss this in

h

aplers — see pages 36 and 74)

The concept shown in this chapler was to

creale a realistic figure of a time-traveling
agent — think Dr. Who mixed with Mary
Poppins, but more modern and a bit crazier

a foxy eye-catcher who would get noticed

Step 02
Creating a mood board

You have read the brief and all the

information; you have ¢

ome ideas floating
around in your mind. Now it's time to fill

your head with in

piration. Photoshop is a

perfect tool to assist you. Simply capture
all your material in an extra document and

name it “mood board”. Collect reference

images: everything that inspires you

pictures fc

pstume parts and imporiant

behe
P.oi

Ji

details of the surroundings, to equipment
and supporting accessories, and anything

that visually des

bes your idea and helps to

communicate your vision. Look for unu:

combinations and follow your instincts

Sometimes you will gel inspiration from

unexpected areas; combine and experi

For the example character of a time-
traveling agent, | collected various images
of old suitcases (visually indicating the

travel aspect). | looked at images of

stewardesses, pin-up girls, and women

in uniforms for example (image 02a). As

a source for references, everyone knows
Google. but be careful with copyright. To be
safe, check out http:/ffreetextures.3dtotal.
com, or www.cgtextures.com. Also

lake your own pictures 1o build your

personal texture and reference library!

To create a mood board go to File > New

N

(Presel: Web, say 2500 = 35 and copy

and paste the elements info it. You will get

% PRO TIP

How to use clipping masks
A clipping mask is a layer that sits on
top of another la being clipped

to the exact size of the main layer
below it. Select a layer containing an
element that you want to paint the
create a new layer. Hit Ctri+Shift+G
and whatever you paint on it will

gel clipped. Clipped layers can be
stacked to any number you like. Hit
Ciri+Shift+G

ain and the clipping will

be released, showing you the complete

original layer in its complete si;

21



New document for experimentation

Select Brush tool

i‘- NEN D

Adjust the Brush size

2
-
-
.
"
”
4

Choose any brush you

4 QOpen a new document 03a

Step 03

In the next step let's get some sketching

practice! We will start with a basic draw

to get things going and later look at

some useful techniques o |

up the

Select File > New (Preset. Web and

1600 = 1200 pixels) and Save the file

as "suitcase.psd”. This will be our new

ood

canvas for experimenting on. It

sraclice to get in the habit of saving often
g e]

and in numbe|

i versions; this is so that

you can go back to your last varsion

ng!

justin case sor

hing goes

In the works;

wn menu

select Painting, so that

s have easy

access 1o the Brush panel (image 03a)
Now instead of sketching direclly on Create a new layer
the w

& canvas background, il

use a new layer for our line art

Create a new [ayer o

In the Layers paletie create a new layer

| ° S
via Delete layer —

You ¢

10 this by

aither

new layer icon or

the Layers panel menu. You ate a

layer by ¢

king on the trash bin icon. N

arent, which is indica

& Create a new layer for the line art



To continue with our example top

of a grab it in the Layers panel and drag it to areas and lo only have the

time-traveling agent, let's skelch the line art its new position, The ound canvas actual dark line art visible, you can use

of a suitcase. It is a simple sh:

pe, nothing itsalf cannot be moved (indicated by a the Layer bl

mode called Multiply.

challenging. so you can fully conc i lock symbol); to turn the background It will do the trick! All white pixels of that

on how lo use Pholoshap. Select the Brush into a normal layer, simply doubi layer will appear 100% transparent

tool (B). Select any brush and set its size lo itin the Layers panel (image Oda) and th k ones will stay visible

something small, such as 3 pixels (see image

03a), and from the color swatches palette

'ote or

To do this, select the layer in the Layers

pick black by clicking on it. Now on your new When brin ] panal, then in the Layers blending

layer you can start sketching (image 03c) Photoshop will give us an opaque v

mode menu (the field where it says
Multiply (
ris in image 0db

layer with the sketch on it, blocking the Mormal), sele
"To move a layer, grab itin  sight of everythir
the Layers panel and drag
it to its new position”

eise. To gel rid of all circled

Step 04
Setting up a layer s ure

Lel’s go through a simple layer setup for

elch

our painting, We have our example

q

on the new layer, with a white backgro

canvas. Why did we sketch on a new
layer? Because we want to be able lo
use our sketch as a guideline, so that we

can paint on the layers below it easily.

Nexl creale a new layer for painting. If
needed. move its position in the layer

stack between the background canvas

and the line art layer. To move a layer

Color Swatches

Line art
(checkered
pattern indicates
transparency)

Paths
E e TOa
100%

Double-click
to turn “Background"
into a normal layer

A The checkered pattern indicates
transparency A Layer setup for scanned drawings




: Blanding Options
General Bloading

Bandng Cptons: Defaut. Bland Mode | Normw £

Spacty
Tukia Advanced Blerding

Stroke

Tamas Shadsy Use History to step back and forth

Inner Slon

Satn

Caier Duwly

Shapes

Sradunt Srerlay

Eatmern Coariny Vertst Magh Hid

Suter Gl
i Bandih Gy
Drop Shadaw
This Layer 0 B
-
Underiyeg Ly o E
-

A The Layer Style menu: a wondrous tool that we don't need for now Im
but that you can use to change seilings of blending modes in

Step 05

Painting the suitcase accessory

Our

use the His

he Opacity

Fo L@ e

et 11 53t
Experiment with the Opacity for your brush

Right-click to open Brush menu
(works for eraser tool as welll)

AN

",

T L ]

Eraser tool (“E”)

eiec

JIAN

-

Layer for basic painting

A With the Brush (or Eraser tool) selected, right-click on your canvas 1o open the Brush menu 05¢c

24



4 Some more examples for the bag accessory. Explore and iry oul various shapes for your characler’s imporiant item

In the next step we'll look at adding some
inleresting textures lo our basic painting

and the

| refine the pain|

Step 06

Working with textures

Save a copy of your lasl document. We nead
the layer set up like before: line art layer on

top, paint layer, then background

vas

Starting with a mid-value background

Instead of a white background we'll start

4 Basic shape and midione background A Define the direction of the light source

way i

with a mid-value background. That v

Duphicate Layer

Delete Layer

Bew Group

Blewr Group from Leyers
Texture layer

Conmvert to Smatt Object

Blending Options.

Create clipping mask

Merge Dewn (8
Merge yible Shifts Cirle
Flatten Image

Animation Options ’
Panel Option..
Clese

Close Tab Group

& Adding lexture to the suilcase

25



provides us with the ground for working
in both lighter and darker values.

From the tool menu on the left of the screen,
select the Paint Bucke! ool (shortcut G), In
the Layers palette activate the background,
select a nice brownish gray from the
swalches (not too dark, not too saturated),
and fill the background by clicking on it

Painting the suitcase shape

Next, activate the paint layer (between

the canvas and line art) with a click in the
Layers palette. Select a slightly darker value
and paint the basic shape of the suitcase
The result could look like image 06a

Define the light source and light direction
In our example the light comes from

the top-right. Select a lighter brown

from the swalches for the areas that

will receive light (image 06b).

Selecting a texture

Next we will break up the CG look by
bringing in a texture. As an example
we will use a photographic leather
texture taken from the free library at
http://freetextures.3dtotal.com

Using a clipping mask

Now for the textures. we'll create a clipping
mask so that our texture will be clipped to
the exact boundaries of the painting of our
suitcase area. Clipping masks on layers
are really helpful whenever you are working
with individual elements in a painting.

Copy and paste a leather texture on a
new layer above the suitcase painting, but
below the line art. Transform and rotate
the layer as needed (Edit > Transform or
Ctri+T). Select the paint layer, as this is the
layer we want to apply the clipping mask
to, and then from the Layers panel menu
select Create Clipping Mask (image 06¢)
Now the texture will only be visible in the
boundaries of the suitcase outline; the
rest will be clipped/deleted {image 06d).

Biending the texture

For a smooth effect we'll have to adjust
the texture a bit more. First, reduce the

26

ice opacity of texture

D

Try different layer modes

Texture is clipped to layer below

4 Clipping the texture layer. Note the small indent in the Layers panel indicating that the layer is 06d

now clipped to the layer below it

b i o o
T e T D
e
ek W S8 ™ e

& Layer mode set 1o Overlay. It looks like a good choice: the result is not too light and not
too obtrusive



2r. Now. to further background and the su

city for a subtle effect :

exture with our painting

ne of the lay:

The aint the floor

overall

your lexlure

er mode

Image DBe s

h the ainting over it

Dodge (wh

xxture layer set to Color

his

er on top of the lir

yer

a litlle too bright for our pu

se), while

a coheren

ng in some
f shows the eff
mode set to O

ect with the layer lors of yo yund

your

ay, which is ju Use the

main object and vice

we are looking for! Experiment wi

I {l)to

the colc

picking
other layer mod

S

mage Dby h). Tip

tool

In the next steg

s you could add a ba:

| be ches)

Instead

mply copy and past & A selection of layer modes. Try to find a I

subtle effect for blending your lexture

't rely

them too muct

in, so tr he new

yer lies betweaen the

our brushwork as well!

P g Vel A v o i s ’

A You can select the colors via the Color Picker tocl as shown, A high voltage” slicker texture is added to the suilcase via Color Dodge I




Setting up your brushes

How to organize your brush sets for a faster workflow

by Benita Winckler

If you want to work efficiently, a well-
equipped and organized brush set is
essential. Certain brushes are more
suitable for particular tasks than others.
On the pages that follow, we will discuss
how to use the Brush panel and how to
save a set of brushes of our own. We
will also look at how to create custom
brushes for various purposes, such as
for painting the skin of our character.
You can see other uses of custom
brushes on pages 154 and 156.

AR AMFRNEN Y AT T

4 Use cusiom brushes and textured brushes to bring "life” into your artwork I

rerrsEE ey

4 Look for the litle icons ~ some brush features can be accessed in more than one place!

28
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"If we want to create a
believable character, we
need to somehow get rid
of that clean computer
look. Custom brushes (and
textures as well) can really
help with this!”

Step 01

The challenge of working digitally
Closely related to the brushes topic is one
malor challenge thal digital artisis usually
need to face. The term “digital” already
gives it away; it is the danger of creating an
artwork that looks too computer-generated
If we want to create a believable character
we need lo somehow get rid of that clean
computer look. Custom brushes {and

textures as well) can really help with this!

As always, the human eye loves a bit of
contrast. So. if we try to bring in some little
imperfections while painting, we'll be able
to better mimic the features of the real
world around us. As a result our artwork
will look more convincing and also way
more sensual. Think about putting a hint
of dust or some scratches on an otherwise
pristine surface to break up that CG
perfection. The key is 1o aim for vanation!

Step 02

Creating a new brush set

Photoshop has a wonderful brush engine
However, on first sight the panels can

look confusing with the oplions to alter the
brushes quite spread out (image 02a), Let's

see where we can find the imporiant paris!

Looking at a fresh installation (in Painting
mode), you will be presented with the
default set of brushes in the Brush Presels
panel (image 02b). Photoshop calls the
brushes “Brush Presets” because for each
brush displayed, a number of features have

been defined, ¢

ch as hardness, spacing,
size, and Pen Pressure sensitivity.

We want {o create our own set, then alter
and create new ones, and importantly,
change their position in the list, so thal we
have easy access to the ones that we need

most. Create a new brush set by selecting

& Brush Presets panel default thumbnails | lvEdd

Save Brushes from the Brush Presels panel
menu (image 02c). In the Save dialog box
assign a name for your set and save itina

location that you can remember. Right now

the set hold a copy of the default brushes

because we haven't changed anything yet

To get the defaults back, hit Resel Brushes
in the panel menu. You can experiment with
other brush defaults from the menu, too.
Either Reset or Append (you can choose
between thase two oplions in the dialog
box once you hit Reset Brushes). The

latter will add those brushes to your set

Appending brushes can cause your list
to grow quite big, so it is good 1o be able
to arrange and delete brushes to make
your brush library more manageable

Let's see how in the next step

MNew Brush Preset...

Text Only
Small Thumbnail
Large Thumbnail
Small List
Large List
Stroke Thumbnail

Preset Manager...

Reset Brushes,..
Load Brushes...

Replace Brushes...

Assorted Brushes
Basic Brushes
Calligraphic Brushes
DP Brushes

Drop Shadow Brushes
Dry Media Brushes
Faux Finish Brushes
M Brushes

Matural Brushes 2
Matural Brushes
Reund Brushes with Size
Special Effect Brushes
Square Brushes

Thick Heavy Brushes
Wet Media Brushes

Close
Close Tab Group
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"“You can create new

brushes by using the .
Brush panel. The new -
brush will hold exactly &
the settings that are "
currently selected” e
Step 03

Using the Brush panel

We have saved our brush set, now let’s
explore how o creale new brushes and then
arrange them for an efficient workflow. You

can create new brushes by using the icon on

the Brush panel (image 03a). The new brush
will hold exactly the settings that are currantly

id

Brush Name

selected. Assign a name and hit OK. The

new brush will be added lo the list (scroll

down to see your new brush). In the following

chapter we will explore the Brush panel,
sellings, and custom brushes in more detail
For now though, just try crealing a new brush

by hitting the icon as shown in image 03a

Create a new brush

Now let's discuss how we can
rearrange and delete brushes. We

will use the Preset Manager A Create a new brush lo be added to your set

FREERERERBREEREERR

Various ways to access
the Preset Manager

Right-click a brush to delete or rename it

4 Use the Preset Manager to manage your brushes: you can arrange their position, rename. or delete them



Presat Type: Brushes w
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Preset Manager

A Select Stroke Thumbnail from the panel menu to see an example of the aclual brushstroke

"Don't forget to save your
altered brush set once you
have made changes to it -
it is easy to forget!”

To rearrange the brushes, simply grab them
and pull them to their new position. Explore
various brushes to find your own perscnal
favorites and then arrange them in a fashion
that feels most comfortable to you. If you
want to delete (or rename) a certain brush
from your set, right-click and select Delete
(or Rename) Brush (see image 03b). To
see the actual brushstroke of our brushes
select Stroke Thumbnail (see image 03c).

Don't forget to save your altered brush set
once you have made changes lo it (see step
02) - it is easy to forget! Also save your set
if you wanl to reset your brushes or want lo
explore the other interesting defaults such
as Dry Media or Calligraphic brushes.

% PRO TIP

You can control the opacity of the brush via
the individual brush setting itself (Transfer >
Opacity Jitter: 0% Control: Pen Pressun
‘You can also do so globally for all brushes
via the icon in the top menu bar (see image
below). If the icon is checked it will override
all Brush presets and instead Pen Pressure
will be used for all brushes. This is a great

littie feature; however, the really interesting

B e e

Small Thumbnail

Large Thumbnail
Small List
Large List

Reset Brushes..

Replace Brushes...

Assorted Brushes
Basic Brushes
Calligraphic Brushes
DP Brushes

Drop Shadow Brushes
Dry Media Brushes
Faux Finish Brushes
M Brushes

Natursl Brushes 2
Natural Brushes
Round Brushes with Size
Special Effect Brushes
Square Brushes

Thick Heavy Brushes
Wet Media Brushes

trait lies in the Opacity slider itself. To have
more control over your brushstrokes, you
can globally set the opacity to a maximum
of 40 or 50%. This way every brushstroke
you make will gently blend into the whole
and add to the painting. This can be very
useful, especially if you work on delicate
areas where you need soft transitions

For bold d

Sure you s

however, make

4 Control the level of opacity of your brush individually via the Brush menu
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% PROTIP

Altering brush hardness and tip sh

ape

g oI ple but effec

but

ir work (this

A You can alter the hardness of the basic brushes via the Brush menu. An oval brush tlip can be useful for control

"You'll need a brush that
assists you in making bold
statements. No fluff or
fuzziness but a hard edge”

Step 04

The secret of the hard-edged brush
Let me highlight one of the basic brushes
that is particularly useful for character

dasign! Il is the ¢

lid hard-edged brush
Why is this one useful? Because in the
early design phases, you'll need a brush
that assists you in making bold statements

No fluff or fuzziness but a hard edge

The trick is that it will force you to focus on
the basic shape of your character design

which is highly important, because shapes
are among the first things we notice and it

Is vital to get them right (s

the chapter

on form and anatoemy in the next section)
Set Shape Dynamics lo Pen Pressure

o achieve a nice brushstroke (image

04a), hard-edged brushes are ideal
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Control the tip shape via “Pen Pressure”
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A Brush panel with settings for a simple hard-edged brush
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A Explore the silhouettes of your character, Use a hard-edged brush 1o find out which shapes are needed to lell your story Im

it Image Llayer Type Select Filter 3D View Window Help
ﬁ-ﬂthhmmxmﬁﬂa fom mw [ Gf @

1o explore the silhou

character design (image

Goo

this

silhouetles are easy to read and

ing that button will set op ’ brushes,
s of individual settings

hance the effl

has on your audi

ousands of liny

jetails. Keep

fuce and

ple:

hance. Which lealures are neede

| your story? ich can be omitted?

Step 05

Brushes suitable for painting skin

some
will crop up. There is no secret formula for

ho

to paint skin; howe some bru

will be better suited for the task t

y to start with a hard-edged brush, either

pressure sensitive or nor

-sensitive (image

Control the opacity (“Transfer”) via “Pen Pressure”

Once the planes and the lighting
g

ed you can sw 1 over o s

speckled brushes (

ee image 05b on the

ne:

page) and finally

i can go over

the paint

g with a soft-edged brush 1o

smooth out some of t A Always use Pressure for opacity, When this is off. the Brush Presat controls the pressure 05a
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Brush  Speckled brush for painting skin
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¥ Spacing
-

Transfer set to Pen Pressure

& Use a speckled brush to further refine the skin 05b A If you need 10 paint freckles, use a speckled brush at the final stage |m

Skin is soft, but the underlying structure
s nol. Itis a common mistake lo start
painting the skin with a soft brush, only
Define Brush Preset

to end up with a blurry, shapeless mess
Keep in mind that the skin is just the top
In the pop-up assi layer of something that has volume and
name such as * form. Always start with the idea that you

are painting an object in 3D space. If you

Brush Name
notice lowards the end that your painting has

lost its life, it could be due to the fact that
you overdid it with the soft brush. Get back
in there and bring in some brushstrokes,
add texture, and do everything to avoid the
clean CG look that we talked about earlier.

Also remember that a character's impact
on the viewer will not depend on how
many freckies we paint on the skin — don't
over use custom brushes or rely on them
as a foundation for your character. If you

absolutely need to paint freckles, as your

& The process of how lo creale a custom brush

character close-up demands it, you can

use a special brush for it (image 05¢)



A Qur new brush right after creation

"Using a variety of brushes

will lead to greater

variation in our brushwork

and it will help you to

communicate the material

you are painting better”

Step 06

Crea ustom brushes

Using a variety of brushes will lead to
greater varialion in our brushwork and it
will help you to communicate the material
you are painting better, Let's go over the

process of how to create your own custom

brushes, 50 that you can make your own
brushes for special tasks. As an example
we'll create a speckled brush suitable
for (but not limited to) painting hair.

Create a new document (set to Web)
and set its size to 100 = 100, keeping the
white background. This will be the basis
of our brush. We will now paint what

will be the tip of our brush with black

Everything white will be transparent
Select any brush with a small size of 1-3
pixels. Now pul down some dots onto

Add texture to the brush

B &

@
@
&
&
@
&
a
@
&

Depth
-
Minimum Depth

Depth Jitter

Play with the settings

Important: save the altered brush!

Brush Name
Name: QK
| Capture Brush Size in Preset Cancel
4 To get a more natural look and to bring in some variety, you can add texiure to your brush 06c

the canvas. From the Edit menu select
Define Brush Preset and in the pop-up
assign a name; confirm with OK (image
06a). The brush will now show up in
the Brush Presets list (image 08b)

Let's refine its setlings so thal we can

use it effectively. As discussed earlier. it is
impaortant to get variety into your brushwork
to achieve a vivid look. The texture setting
is especially interesting here, as it allows
you lo add lextures and variety o your

brush (image 06c). If you want to paint fur or
grass materials, you can create a brush tip
consisting of small strokes instead of dots
and then combine it with Scattering (above
Texture in the Brush Presels panel). You
can also enhance the effect by using the
Shape Dynamics: Size Jitter/Angle Jitter.

There are many possibilities so |
highly recommended that you try
out the various brush settings. Have
fun - and don't forget to save!

w
3]



Setting up your color swatches

How to work with complementary colors, use the Color Picker, and convey moods

by Benita Winckler

In addition to technical concerns (such as Visible light

how to work with complementary colors 400 500 500 700

or how to set up color swatches), we also

need to know about the psychological and |
physical effects that colors can have on ’ w
us (consciously or unconsciously). What

is the response we want from our viewer? & Color specum of visibie light: warm red at one end. cool bueivioletat the ather | 01a |
Which colors convey a certain mood
most effectively? We need to ensure calming or sad; think of “feeling blue be linked with solitariness, royalty, and
that we communicate the right things. or being “ice-cold” (image 01b) spirituality. It can also be associated with
mythical topics and otherworldliness
Step 01 « Green is associated wilh nalure
Some colors and their effects health, and growth. It has a calming We will explore the many eff
hows an illustration of the and relaxing effect (image 01c) uses of different colors and color

of visible light. Lef's break combinations further in the “Storytelling

| down to get a quick overview. * Violet is a combination of two very different and moods” chapter of this book
colors: cool blue and fiery red. It can (see pages 74 and 76-78)

ery active color. Hot

sual. Think of glowing

fire, blood, fruit

oisonous fungus!

s an allention-grabber, it's not as
anding as red, but is still very warm

and can

ciated with youthfulness

un, ambition, and high energy

ltention s clated

1, happiness, sunlight, and

s also used as a wamning

me animals, such

3 WEspS,

4 The blue color scheme adds a cold 4 The character is more approachable
atmosphere to the image due to the warm, golden, green fones
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|Place or Drag Raster Images as Smart Objects
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History Log

A Setting up the HUD Color Picker

Step 02

Using the HUD Color Picker

There are several options you can use
to select your colors in Photoshop.
One feature is the HUD Color

Picker. Lel's set up this feature

In the top menu bar select the Edit menu
and choose Preferences > General to
open the Preferences panel. We want
1o look at the Hue Wheel. so select itin
the drop-down menu (see image 02a

Alt+click canvas

A Exploring the HUD fealure does take
some practice

above). To use the Color Picker feature,
select the Brush tool (B), go to your
canvas, and practice the following:

- Alt+click the canvas to color-pick
the normal way (image 02b).

* Next try holding down Alt+click while
hovering over the canvas. You will get
the option to alter your brush size by
movingfhovering to the lefi/right (image

Alt+elick hovering over canvas

4 Alt+hover-click allows you to change
the brush size

e

02¢), If you movefhover up and down you
can change your brushes’ hardness.

* Hold down Alt+Shift and click; the canvas

will set a color sampler on that spol. To
get rid of it again, simply click it another
time with that key combination held down

and it will be removed (see image 02d)

A Alt+Shift+clicking the canvas will set a

color sampler, Click again to delete
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'‘One useful technique for
color swatches
photographic

“e image is to use
aic Filter”

If instea cking the canvas directly

you hover and click, the color wheel will

open (see image 02e). Keep all the keys
held down {also on your pen) and you
can move around the wheel to select a

new o

lor, while being able to see the

color's

the color wheel. If you

need to find a color that has the greatest

contrast to another chosen co have a

look at its opposite position on the wheel

Step 03

Color swatches are useful if you nee

(¢}
create your characler within a certain given

color scheme. M your client has already

given you a painted image with some colors

for reference, and then you can color-pick

from that {(image O:

Or maybe you were

given som : references, to

& photograph
creale something that will have the same
look colar-wise. In this case it can be a

bit more difficult to do the color-pick

aq

One useful technigue for crealing color

swatches from a photographic reference

nage is to use the Mosaic Filter, turning

0 a8 mosaic.

A Create a mosaic out of a given reference image to achieve a basis for a

Open a beautifully colored photograph

use as a base. We want to copy the
background layer to have something to
ack 10, so select All (Ctri+A), copy
{Ctri+C). a

layer will be

i paste (Cirl+V). The new

sed for

e filter. Click on

the layer to activate it, and from the Filter

2cl Pixelate

menu in the lop L bar s

> Mosaic (s ge 03b). Depending on

the blocks. you will get a good

¢ of the ma

jor impartant colors

1the size, to get a suitable

s, where you can clearly see

separatec

s to pick from

). Next [ ur colors from the

our own palette (either

mosaic and pe

or directly on a new

your main character docume

A Brush selected and Alt+shift+hover- I
clicking it will open the HUD color wheel

Darkest dark

L Lightest light

nt to note, as they are great to use for

ing the Mosaic Filter may cause you to lose some

the original source to add to the color swatches

possible color scheme. Play with the settings for the block size

03b



& Adjust the cel size or use the slider to get a good resull

| Color Table

[oo]

& Click on the empty slots to open the
Color Picker and select a new color

Due to the reduction of the colors. you might
lose some pretty highlights and dark values
(refer to image 03a). To add them to your
color swalches, hand-pick them directly from
the original photograph with the Eyedropper
tool (1) and painl them on your palette

Step 04

Color swatches from index mode
Indexed Color mode uses a color look-
up table to create an image Itisa
method for creating 8-bit, 256-color
files. It is useful for saving disk space

and creating web-based images

Open your reference photo. To keep it
simple, take an image of JPEG or PSD
format. We will use peacock fealhers again
We will be messing around with this image
in @ second, so make sure you save it under

& new name so you can safely play with it

What we wanl to do is extract a number

of beautiful key colors, while omitting the

| <=
|-

|
1B

‘am

i Faamong © adehe
A

d

]

Where is our color table file?

L o T R

il this time we wanl lo

superfluous ones, B

create a set of Pholoshop color swatches
from the image. Color swalches can then

be loaded, saved, or even exported (o

other programs § Mustrator

From the top menu bar select Ima

> Indexed Color, In the pop-up menu enter

a small value and watch how the image
changes accordingly (set Dither to None to
achieve clear color shapes instead of dotted
transitions) and hit OK (image 04a). To get

our swatches from the indexed i

ge
Image > Mode > Color Table. In the pop-up
menu you can see the swaltches: hit Save

assign a name, and hit OK {image 04b)

Let's open our new Color Table

mage

04¢). In the Color Swatches panel menu

=

A Play with the numbers and watch the image change accordingly

Impartant: change this to “Color Table” (*.ACT)!

=

4 To add more colors click the icon as
shown above

either click Load Swaiches (to add the

tches to the exisling ones; image

) or Replace Swatches to replace the

existing ones with the new sel. Note that

you should make sure that in the pop-up

U you nge the file type to Color

(ACT]). so that your new file will be
y

displayed. Select your file and hit Load




A Black-and-white skelch, It is useful 1o
focus on the lighting first

& The chosen color scheme: red, elecinc
blue-turguoise, yellows. and chartreuse green

Channels

Layers
fpma: o T oo™

Paths =

Solor, a

A Repainl the colors of some areas using
@ new layer with the blending mode set to Color

Step 05

d for Hue/Saturation Let's start

+ for color changes

40

of the black-and-white

4 Adding the dominating color. The color

layer is above the sketch layer. toning everything

"Another really fun
technique you can use

is to invert the colors

of your current layer by
hitting Ctrl+] to give a
photographic negative
effect. If only used on one
part of an area in your
image it will give you the
maximum color contrast”

to change the color of in the new color

you have finished, merge down that

Layers panel menu > Merge Down)

the colors of an existing layer,

e colors for the whole image

use the command Ctri+U. This will b

g
up the Hue/Saturation dialog box (image

06b). Yo

can play he seftings by

moving the sliders to achieve some fresh

deas for possible color schemes!

Another really fun technigue you can use

colors of your current layer

by hitting Ctri+| to give a photographic

nege

ve effect. If only used on one

1t of an area in your image

D6c shows the final character so you

of the final colors chosen




* PROTIP

You have an iconic
candidate!
When designing chal s and

you are not sure if your ideas
work, it can be helpful to translate
r design into a new style:
say a comic figure, a children’s
drawing, or a caricature of your
original. Something reduced
that will show the important
parts. Are you are still able to
recognize the character? If
yes, there is your hint — you
have a good thing going!

& A children's drawing of the character

Hue/Saturation

Children's drawing of the character

y ’o’
A ’ 4
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Establishing your
character

Discover key art theory techniques and top tips to present
compelling and recognizable character designs.

You now have the knowledge 10 set up your workspace and tools, bul
how do you go about designing a convincing character? In this section
Benita Winckler will present some notably recognized theories linked
to depicting a character. Starting with form and anatomy, Benita will
then take you through character types, composition, storytelling, and
moods, using images to demonstrate definitions and discuss the clues
and tools behind communicating an effective character creation.



Form and anatomy

How to portray your character through the use of body types and gestures

by Benita Winckler

’%{*}E, =R Sl

gzt
4 97 &
) g - *
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The human interest in portraying

characters has a long history, in some
ways making character design an ancient
art form. Nowadays artists have the

mighty Photoshop available, but the basic

problems of how to present a character
in the most compelling and recognizable
way still remain. To make a character
design work, you need to consider
many different aspects, including form,

shape, posture, and facial expression.

It's also important to understand that it
all starts in the mind of our audience,
The more we know about the clues
and magic tools behind the art of
communication, the more powerful

and effective our creation will be.

A character consists of much more than
just his or her high-tech armor. If we can

manage to scratch at the surface and

JHeAds ] JHeAds

bring out what is behind the fabric, metal,

or painted mermaid scales, then we can 4 The human figure is about 7-8 heads high as a guidline Im
show our viewer a real “person” and they

will be able to make the connection. of us: for example riend or at we are afraid of someone, or that

‘oung or old?
Step 01
Form and anatomy information
Form is one of the first things we perceive yur brain s/

when looking at a character. Based

appearance, the anatomy, and the

we start lo make assumptions on what

we can expect from the character in front our e

S



hape this can give y A Basic shapes can e
sharp, dangen Ci

& Combine basic shapes for new character ideas! Here. a round
some spikey triangles (possibla danger) creates a rascally beastling
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* PROTIP

Break the rules

soft rounded forms on a male.

Step 03

Differences in female/male portraits

So, what is it that makes a male face look
male” and a female face look “female™?

If you lake a look at image 03a. the generic

male has hard lines, angularity, features
as if chiseled from a rock, a strong jaw-
line, and a square chin. The female portrait
shows delicate, rounded features, overall
soft curves, and no harsh angles.

To produce a male-looking portrait, draw
the head shape a bit squarer and more
angular. make the neck shorter and
thicker, and add the Adam's apple

For a female head, draw the lines rounded,
with less sharp corners. Her neck will

be longer and thinner with soft curves
instead of straight lines The skin tones
can be darker for the male, indicating
rough features and a hint of facial hair; for
the female paint the skin light and silky

For your female portraits, paint the
eyebrows in a fine soft curve. You can see
the effect of masculine bushy eyebrows
on a female portrait in image 03b

For females paint the eyes more open
and bigger than the males’ To enhance
the fermale touch you can add eyelashes
and eye makeup. For females paint the
nose delicate with finer features

Female lips tend to be fuller; however

males can be equipped with beautiful
lips and stll look masculine

46

A Generic taces in ¢ Notice the

Step 04

Facial expression and mood

Unless our character is a very good aclor,
poker player (or has had lots of Bolox
injections that prevent the facial muscles
from working), we will be able to tell his

or her emotional state from the facial
expression and the look in their eyes (image
04). Are the eyebrows raised or furrowed?
Are the eyes wide open or droopy half-
awake? |s the mouth relaxed? Smiling?

There is a great variety of emolions, positive
and negative, and our facial features will
display them accordingly: happiness,
pleasure. interest, disgust. anger. contempt.
fear, and surprise, just to name a few
However it will help a lot if you don't just stick
to these basics; instead try to invent some
sort of context for your character — a story, a

& Thick, bushy eyebrows for females will I
creale a masculine effect
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"A look can be challenging
or inviting; it can signal
interest, involvement and
warmth, fear, sadness; or it
can seem brutally cold and
intimidating”

Step 05

How do you

ve your character that sp

look”, which really brings them to life?

Just as in the old saying, “the eyes are the

wing to the soul”, you can use the eyes

of your character to communicate how they

and what they are thinking

A look

challen: ar inviting; it can signal interest,

nvolvement and warmth, fear, sadness, or

can seem brutally cold and intimidating

take a look at im

1 als

thal a

acter that is directly looking into
the camera can have an intense effect
on the viewer because of the connection

that will be established

- It addresses

A Depending on the intensity of the emotion, the whole face will be affected, stretched and l

and invalves the viewer dire
twisted. by the expression

tly. This can

be a useful trick so keep it in mind!

Eye contact!
R=

A Characters who look directly inlo the camera can create an instant
connection with the viewer. Use this litthe “trick” to engage the viewer

& Hiding parts of the face behind a mask will obscure the expression | et
of its owner, causing the viewer to guess what lies behind it




4 Some generic female body types I
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A Maore categories for female body types

Certain physiques carry cert

it but fearful, with ve of

1g-distance sports, such as marathons

at r > males. This

n: in females the

asy-going

morphs are adventurous

id hips, and thigh:

of males,

competitive, aggressive, and ener

ed, int

of your

Step 07

Categories for body shapes

erences in form and shape held upright

in our fellow human beings

the e

examining the peo

N
L i
i * PRO TIP

Silhouettes

Silhouettes are a great tool to explore

the effect of a pose, to check if it
really works. Also, they actas a

quick way to focus on shapes a

designs

the viewer. A good character will be

A Explore the effects of different poses by using silnouette drawings. The shape alone can easily recognizable as a silhouette
communicate a lot about the inner state and mood of a character
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Step 09

Curves, rhythm, and motion

Since character design has a lol o do with
producing an emotional response from

the viewer, the more life-like a design, Symmetry:
the easier it will be to connect with our passive, stiff
(a bit boring)

audience. We need to capture the energy
and attitude of an imagined, “living” being.
In a drawing we can work with the lines and
curves (o tell our story and give a sense of
mavement and excitement o our creation

Inimage 09, you can see the effect that
symmelry has on a pose. Il will look stiff,
dead, and a little boring. But, if our mode!
is presented in an asymmelric pose, as
seen on the right side, the flowing curves
will change that impression instantly.

Step 10

Body language and gesture drawings
Non-verbal communication plays an
important role in human social interaction
Even if we don't speak, we still communicate
via our body language. According to

some studies aboul the communication of
emotions by Professor Albert Mehrabian,

if a person sits in front of us, talking about
their feelings, we will react to 55% to body

Asymmetry:
interest, action,
excited movement

A Note the effect of the asymmetric pose: the flowing curves give a sense of molion and balance Im
1o the pose. Our skeleton comes to life!

Flowing lines suggest balance, rhythm, and vivid movement

4 Initial gesture drawings. The red lines illustrate the rhythmic flow. Use asymmelric curves to indicate movement, direction, and balance!
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Describe the outer form with dynamic, asymmetric curves
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Avoid lifaless “snowman” effect



& Expressive hand poses will enhance the storytelling aspect of your character

A The hand, holding the delicate scarf of the dress, adds to the seductive pose of the characler

"Capturing some spark

of life in a drawing or
painting is where the real
magic appears”

language, 38% to tone of voice, and only
7% to spoken words. That means that while
we are walching the person in front of us,
we will subconsciously “read” his or her real
feelings and attitudes. no matter what they
say. As artists then, we can use the effects

of body language to communicate our story.

To find a nice. lively pose for the character,
it is helpful to start with some quick gesture
drawings (image 10). These are simple

draw

1gs that capture the essence of

a pose. Is the character happy or sad?
Aggressive or passive? These basic
qualities should be apparent in the imitial

lines, ready to be taken further in design

Capturing some spark of life in a drawing
or painting is where the real magic
appears. The more we render and rework
an artwork, the more we tend to kill this
off. Make sure you keep the lines vivid
and loose right from the beginning,

so thal there will be some energy left

shimmering through in the final illustration

Step 11

Expressive hand g

Another way to enhance the look of

your character is to pay atlention to the
expression of the hands. We use our hands
whean communicating. Some of us do it

more than others. There are subltle poses
and wildly exaggerated ones. Hands can be
used to point al things; they can be clawed in
anger, or opened in friendship; they can be
inviting, seducing, demanding, or defending

Sometimes simply looking at a characler’s
hand pose can offer sufficient information
to understand what kind of character we
have in front of us. There are so many cues
we can get from analyzing the way people
hold their hands: if someone is biting their
nails, for example, the person appears
amxous and unsettled. Hand poses can
therefore be used with greal effect to tell

your story (see images 11a and 11b)



"As human beings we have
the ability to be empathic
and the more similar the
other being is to us, the
easier it will be”

Step 12

can we
human

without losi

beings do - take a look at | 2 in image

12c for example. Play this

balance t

e whal you cz

4 To make the audience feel uncomfortable, add alien characteristics that prevent an emolional & This guy seems to be rather unlikable,
connection but has relatable human characteristics
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4 Hybrids are great fun 1o paint. To get inspiration, simpl

ok al the animal world and combine elements to create a new design




Character types

What makes different types of characters recognizable?

by Benita Winckler

We tend to perceive the world around
us with a lot of biases; stereotypes do
exist. If they are overdone in an artwork
it can look kitsch and our reaction will
be either boredom, or amusement if
the presentation is really over the top
and intelligently done so on purpose,

As character designers we need to be
aware of known character types and
the associations that go along with
them. The big task here is to create
interest and avoid generalization
(where the result is boredom), while at
the same time showing our audience

something that they can relate to.

To do so, we need to open a door into
the audience's past experience. We need
to find something that will connect with
them on a deeper level. If you are able to
talk to your audience about something
that is meaningful to them, which

taps right into their feelings and their
emotions, then and only then will you get

a response for your artistic endeavors.

If you want to be understood, be original;
but don't stray too far from a certain
type. If the character is evil, make them
look evil. Let's talk about the various
character types and how we can use
visual key elements to make sure that our

character will be perceived as we want it

A Character line-up with some standard cliché character types amongst them

& Heroine character. Nolice the strong stance and the commanding gesture



Step 01

eroines

The mai

1 character for most storie

the hero

or heroine), or th

(or girl). This doe
muscular superstar
half- or top model; but the character

joes has to have cenain features and

s that will make them

tuation

ognizable as a hero in any s

Let's analyze what makes a ter

pear to a hero. In the previot

chapter

ve lalke

efly about the effect thal sha

n have in character de:

n: triangle

dangerous fealures; squares for

ility, and circles for friendliness. This is

to communicate an idea. A

proach is to k 18 mix of el

when seen together w

& Anocther example of a heroine character

stics. El

hero are a

strong, uprigh

back, wide chest, an

ac

nanding hand gest

also suggest s

ough be aw

a little unarmed

the jewelry and the insignia of

e uniform suggest ¢

Blond hair

oks good on angelic characters

These are the

hara

% PRO TIP

Add some contrast
To make the character really stand out,
always aim for contrast. Try combining

the hard (or even nasty) features with

something nice, charming, and beautiful

& A villain Elvin warrior

ver his shoulder gives a nice spiky

inter-like triangles,

janger,

ing a certain dynamic an

p

s may wonder what il is with

all this analysis of small details: it's important

ber the importa e little

ok at im s the

ge 02b, it s

ar facial features

n
U



A Guess her character type!

4 Some goofy/funny characters produced in a stylized comic style

"If you need to paint a
powerful femme fatale
for your project, first think  story
about her story. What is In what
your character's mission?”

Step 03
Femme fatale and pin-ups

e femme fatale; think of snake

* PRO TIP

Use lots of layers
If you aren't already doing so, work with

layers. This will allow you to exchange
elements during the process of the
work. There is nothing more annoying
than having to repaint elements
because of premalure merging
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Step 04

The goofy/funny character

© Mosaic Mask Stixko

¥ guy the right is o

the ev g lady or left is the
an Let's analyze the leatures that

make the hero look pariculz

goofy

: the pose. His stance is quile

crooke nd stooped. He is a g

{smiling, open expression). but

and clumsy: the ¢

J4a as

F
3w

town. The overgrown

all atmosphere

stef

“Feel free to overdo the
physiques: strong fightin
types can do with a bito
unnatural muscle mass”

r. a character

fully armored. \

the functiol

of the equipment be

starting with the design. Most people will

probably never notice word is made
d, or if the

anough or too short. For a

owever, there is extra

o make sure the armor and

A Warriors need recognizable as well as functional weapanry
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% PRO TIP

Create a focus point
To pull the focus of your viewer to a
certain area, make sure you give it the

greatest contrast in your image. This is

where you will want to put your lightest
lights and darkest darks (see more
about composition on pages 62-71)

Let's talk about magic. When dealing with

magicians. a certain amount of visual |

fireworks have to be expected. After all

they have supernatur

power and know {

how to bend and

anipulale reality. We'll il

the theory and open Photoshop

to create some fireworks for ourselves

Image 06a shows a magician character. As

nd. Instead | have played
with a mixed effect of exotic costume, hand

gesture, and light o suggest the magical

act of spell-casting. To ¢

& The costume hints at the profession. Symmelry leads the eye to the magical hand gesture

s
5.

Select Brush tool (b)

Paint some rough strokes

PEN7HR ANFRNRRAN

(=
o

Create now layer: “magic light"

=

4 Select a new layer 06b
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Set Layer mode to
Color Dodge

Note the effect on the light!

4 Select Color Dodge 06¢

Hit Ctri+U to open the Hue/Saturation

Preset: | Custom

Master

Saturation

Increase the value for Saturation;
decrease the value for Lightness Ughtness:
Colonze

V' Previaw

A Alter Saturation and Lightness. 06d

Select a new layer to paint on and na

it “magic light”. With a textured brush,

saint some rough strokes. Choose muddy

colors for this — no extremes (image 06b)

From the Layer mo:

the Layers palette, select Color

Dodge. This mode can cause some

interes affects

(image 06¢)!

With the “magical | layer still

selected. hit Ctri+U 1

open the Hue/
Saturation dialog box_ Alter Saturation

N6d)

Carefully Smudge
the flames
{don't overdo it)

and Lightness (see i

soft brush tip Carefully use the Smudge tool to

soften your brushstrokes. Note: image

s extreme smudging. in
A Use the Smudge tool 06e

er 10 better illustrate the effect
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A Elite paladin, marked from endless fights

Step 07

knight or paladin che

similarities to the warrior charz

has been said aboul the weapon

Il take better care of

jrance than a warrior living out

However, if a knight has

Again, think a

slory will have an influence on the

Has the

your knig

white horse

mposing poems

Considerations such as these wil

ability of

y artwork you ¢

pear as a group or more than once

t can be helpful to give

the group a visual e

. Image 07b s

e rounded ¢
the helmets also gives a visual

t are members of the same si

Step 08

Skeleton kings and r royals

fon't offer that r 0ssibilit

acial expres: with a bit of artistic

60

ssion Is o use

i

& Paladins on their way into battle

& The crown indicates her rayality

Step 09




% PRO TIP

Experiment with scale

To play around with the scale of
your character design, select and
copy your design, then use the
Transform tool (Ctri+T) to scale it
up or down (hold down Shift at the
same time to keep the ratio)

JHerDs

A How can we lell if the character is a child? The secret lies in the relation of head size 1o body Im

A Ayoung orphan boy. His clothes don't fit and the huge hat further enhances his childlike appearance © Sauerander audio/Argon Verlag
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Composition and positioning

Techniques and rules to enhance your designs

by Benita Winckler

If you want to enhance the visual
impact of your design, you need to
decide on a good position for your
character within your compasition.
Certain compositions will work better
for a given task than others.

In this chapter we will look at the different
of various itions. We will

look at rules, such as the golden ratio

and the rule of thirds, and will discuss

C

A B

D E D
consthucy a fguace AZCD

how the application of them can improve
the appearance of an image. We will also
examine some of Photoshop's tools that

make composing an image much easier.

Note that composition rules do

apply for character portraits. We will
therefore look at the subject of the
framing of a portrait. We will explore
possible pitfalls in composing portraits
and learn how to avoid them.

Composition not only works on a macro
level (big shapes) but on a micro level

as well (inner coherence). To achieve a
harmonious result, a composition needs
to work on all levels. The trick is to not
paint parts in isclation, but instead relate
them to other parts. Playing with the
macro and micro in your composition is
a lot of fun; it will help lead the eye of the
viewer around the image, ideally directing
the speed and flow of their attention,

E o D
cnunfrue-‘ p.alfu.\-f» =

G A B

E C

W3l cevtey T aud radir FE
drois an a-c Cressing £C

G

AGTD
isfbe

J}/M

D E C
Qﬁ;‘:‘ucﬁ- o g pecu

D
odrcenlor Fo 2F at+
Eckowol AB o ok smed— Fhe preptiodicale —

C
at 6

A An approximate of the golden spiral, a logarithmic spiral whose growth factor is the golden ratio or phi
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w
A An example of a design that can be |!

described with the golden spiral

Step 01

The golden ratio

Without mathematics there is no art
Fra Luca §

Pacioli {a contemporary

of Leonardo da Vi

The human instinct for the detection and

appreciation of beauty is one of life's greal

mysleries. Sure, beauty lies in the eye of

beholder, but there are proportions that

commonly accepl as beautiful and
aesthelically pleasing. The first discovery of
the golden ratio dates back as far as some

hundred years BC. Since then numerous

mathematicians and artists alike have studied

and worked with §

he “divine proportion
Examples of creatives who have worked

with the golden ratio include the famous

archite 2 Corbusier, who proportioned
his work approximately to this ratio. Another

example is Leonardo da Vinci, who used the

golden rectangle extensively in his paintings.
You can construct the aolden propartion
(which is the beautiful number of
1.6180339887, represented by the Greek
letter Phi) by following image 01a. As you
can see, the golden spiral is derived from

the golden ratio and is an organic w

lead the aye of your viewer around your

& Another example of the golden spiral. Here the background elements are framing the
character in a spirally flow

composition. It draws the eye

to where you Although numbers are a fascinating lopic

want it to focus. Your subject can sit in the let's not look further at the math here, bul

ection or, for great impact, in the center ralk of its use

er inspect the possibilitie

see images 01b and in our charac gn compositions



Step 02

Photoshop tools for composition

2n starti

nstin

a rule

not until t

thal we have wed an inner ide

a harmonious arrangement that

made visibl

am, such

by overlaying a

as the gold This is ¢

point: when laying out an initial design

A& Select the Crop tool o refine the A The overlay grid shows whether the
composition and framing of the character design is working

c pulie -
Crop tool. If you want to che A Anchor points are pulled to re-frame the canvas

works or if it can be optimized, simply use

1ents

the Crop tool to shift the important el

1o the s ots of

5 compaosition

(for example, ere the comy

intersecl and create a focal point)

A Left: balanced; middle and right: tension because of the conltrasting sizes

Open a sketch. From the toolbar, select
the Crop tool (shortcut C). The Crop menu

has different options; s

get an ow

golden proporti

intersections are a good place for yo

ter of interest. Pull the anche

(image 02¢) to shift areas of your i

{o the: ions and im

tion. Hit Enter to confirm; then you

SO P —— A Two ideas for dividing the canvas horizontally and vertically
A 2ontinue 2 WO On YO ae

& Add diagonal lines to divide the canvas into inferesting sections Im

64



& This technique works the other way around as welll Use shapes to analyze a sketch and then play with the composition as discussed

Step 03

How to generate composition ideas
Breaking the spell and coming up with new
ideas out of nowhere can be a challenge
Lel's look al a way to discover possible new
ways of placing our elements on the canvas

Start with a blank canvas of any size
you like, say 600-pixel = 900-pixel
screen resolution (this is going to be a
rough sketch for exploration, so there
s no need for print resolution at this
paint). The example discussed in this

step is in a landscape orientation

4 The final composition

With a hard-edged brush, paint two
Interacting abstract shapes on the canvas
Note the different impressions of the abstract
shapes. To creale tension, draw one shape
bigger in relation to the other. If two shapes
are seen as identical in size. they will tend o
balance each other out, which will result in a

calmer and less dynamic look (image 03a)

We're going to continue with the batanced
version on the left, louching upon the rule of
thirds. The rule of thirds involves applying
a physical or mental grid over your image,

usually made up of four horizontal and

o]

vertical lines, and placing your focal point

on the intersections or along the lines. Start

hstrokes) the canvas

Then

o pul the center of

ng it in the canter

MNow add diagonal lines that further divide

the canvas into interesting sections (ims

03c). Later on y

ou can refer

of action” when sk Shapes help

to analyze a composition (image 03d)

and can be a guideline for simplifi

Image 03e shows the final comy
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Step 04
The center of interest is basically about
fascination. One area of the picture is given
the quality of crealing a powerful attraction
If all goes well it works like a charm and the

focus of our viewer is magically drawn to it

For a successful center of interest, ensure
that other elements of the picture do not
create distraction; they should support the
effect. If their appearance is too intense
elements will start to compete, diminishing

the intensity of the area of interest

Image 04 shows some interesting
compositions. In the top-left the scribble
shows a compaosition with a center of
interest reduced and simplified for maximum
effect as a dot in the middle of nowhere; by
eliminating all other elements in the image,
the viewer has no option but be drawn to

the simple object in the composition. If we

zoom in (lop-right), we can detect a pe

Interesting! Coming even closer {mid-left)
we naturally focus in on the face and the
geslure (the center of interest is placed at
the lop-left intersection) until we are close
enough see the beauty spot on her skin
{mid-right). By placing the center of interest
along intersections we are following the
rule of thirds, which helps to emphasize
the focal point in the composition

For mandalas (bottom-left), a centered
focus area might be acceptable. Portraits
of royals (bottom-right) or other awe-
inspiring figures can benefit from a
symmetrical composition, with the center
of interest placed in the middle instead

of somewhere to the left or to the right

Give one part of the artwork special attention
Decide where the viewer should look and this
spot will have to hold the greatest contrast
the richest colors, the blackest blacks, the
whitest whites, and the loveliest details
Step 05
How to create dynamic comp

In the first chapter of this section on
establishing your character, we briefly hinted

al the effect of form in character design. It
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A The cenler of interest in different sketches Im

é :

A Adynamic composition versus a static composition Im



Step 06




ming the ¢

jeal with two types

ry item you put on a canva

hange the c

cter that has been ¢

back into

The Iz

see the

repetit

1 the right

sign

on for e

w this

Next cr

and fill it witk

| 082
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Step 09

4 Exampie of using lighting 093

& I everything is dipped in shadows, it would be hard to read details of the costume, for example lm



A When painting characters in a selting, you can start playing with the composition Im

find a good mixture of atmosphere
and technical clarity (image 09b)

i i ‘ * PRO TIP
"Playing with all of these \f ties in a cor Flip your canvas
qualities in a composition jive ar k a more dramatic flow To check the composition, use the
can give an artwork a more flipping command. When working
dramatic flow" an on an image for a long time, we

become blind to it in a way, accepting
how it looks without noticing the
arrors. Flip the canvas and rotate it

around to gel a fresh look (use Edit

> Transform to bring up the menu)



Storytelling and moods

Discover narrative arcs and visual clues

by Benita Winckler

Let's begin with a question: what exactly
is a “story"? One answer is that a story
has a beginning, a middle, and an end.

If we are looking at the narrative arcs
of fictional stories for example, we will
find that in the beginning a character
will be introduced. We will get to know
the surrounding envirenment and

the people the character is involved
with. The middie part will feature the
adventure, the difficulties, the twists
and turns, the ups and downs, before
finally, the story reaches its climax.
After that the curve goes smoothly
downwards again and the story ends.

Although the medium of a visual
image is a bit different to that of text,
wae still have a person in front of us
({the viewer) who likes to be led on

a journey, just like a reader does.

Step 01

The problem of a single frame

What needs lo be done to map a similar
curve of excitement for our illustration? Here
comes the first challenge: we only have

one frame. If you are working in animation
or film, you have several frames available
and you can take your time to introduce the

character and so on (images 01a and 01b)

w o you build up tension with just

image? Qur compaosition needs lo
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4 A namative arc for fictional stories

be carefully crafted. Then a timeline effect
will happen in the mind of the viewer, as
they follow our direction and decipher the
visual clues we have laid out for them

Step 02

Directing the view

A powerful method to direct the view of
your audience is i have other figures
logking in that particular direction. Think
aboul those everyday situations where
people form a crowd and gaze at something
- our reaction is to think that it must be
exciting if so many people stop to look at

il. Mos! imes we al leasl gel curious

In image 02a, for example, the viewer's
eye follows the supporting characters
direction of sight. All the boys focus on the
center figure, where the candle is shining

the viewer will look there as well

When it comes to light sources. humans are
not so different to moths; we like a nice light
source. Light attracts interest and also directs
the view (image 02b}. A character in the
spotlight will demand our attention naturally
You can either have the light source visible or

you can omit it, showing only the lit character.

Another thing that demands our altention Is
movement. Our characters are supposed to
be life-like and believable, so if something
altracts attention in the image, they will
look as well. Movement can be difficult 1o
pull off in an image: however, we can show

our characters focusing on an object

Step 03

Location and time

Who? What? Where? When? These are
all important questions in storytelling. To

visually indicate the location and the lime
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A Several frames are used in animation

N

& Using light to direct the view. Note the characters’ attention 1o the movement of the owl

& The location plays an important role

A The bagpipes sugges! the location



4 Define a number of swatches or paint your palette into a new image I

WAL J...

A Play with the dominating color using a lextured brush

Jr X I

A This color scheme is dominated by warm red and golden hues

"You can greatly enhance
an image by giving it a
clear dominant value. This
can be the middle value,
the light, or the dark”

Step 04

Spring and summer colors

When making design decisions for a
character, an effect that is often overlooked
is the use of seasons. Let's first look at
springtime: nature s back and it's time

for colors! Subtle cool hues can serve as
contrast for the pinks, reds, and fresh greens
The maood is joyful! Place your character in
a spring scene o convey positive feelings
Show blooming trees and clear blue skies

Summer conveys the feeling of perfect
days outside. with deep blue skies and
warm air. Everything looks bright. rich, and

vibrant. The colors are brilliant and intense.

74

and the shadows are strong. If you look
around during midday, notice that the light
is almost overpowering, washing out the

highlights and casting harsh shadows

You can either select colors intuitively
from Photoshop's Color Picker (or color
wheel) or you can collecl color inspirations
from photographs and paint your palette
from there (images 04a and 04b). You

can greally enhance an image by giving

it a clear dominant value. This can be

the middle value, the light, or the dark

Step 05

Autumn colors and winter colors
Autumn features the most wonderful hues

of gold and russel colors, but on bad days
autumn can offer ideal conditions to portray
gleom: foggy streets, heavy rain, wind
pulling at umbrellas and hair. You could have

the character grab the collar of his coat to

Im A Amuted palette with plenty of opportunity to paint blue shadows

[oss]

keep off the cold or, if you are aiming fora
playful mood, positively surround him with
whirls of golden leaves. Adjust the outfits
accordingly; add scarves or earmuffs

A winter palette basically consists of black-
and-white, bluish gray tones. With most
of the colors missing you can only play
with the effect of warm light against cold
Dominating cool areas are perfect to be
set off by red glowing spots of fire or the
warm fight of interior places. Explore the
possibilities of outside/inside scenarios
The mood caused by winter, if analyzed
further, will show an association with an
archetypal danger. but also mystery and

wonder. Think starry nights and virgin snow

Step 06
Archetypes and symbolic elements
Since our image is lacking a timeline to

tell our story, we have to find another



A A character on her way back from the underworld

& She carries an opium poppy. symbol of Morpheus. Ged of Dreams

% PRO TIP

Working in an non-destructive way

Often you will work on a project and then at some point
you will need to make changes to your design. What if
you have merged your layers. deleted your reference, or
saved over an old version because you thought you won't
need that one again? The solution: work in an organized
fashion. Keep old versions. Save numbered iterations.
And use layers, masks, layer modes, copies of layers, and
s0 on. It might save you time further down the road

T



Analyzing the distributior

> color scheme s U

ation to get the

ments., st the

silver hair

n skin, are harshly offset by

es are alian

Interestin
atmo

normally

friendly

expression

rally a

key element 1o set t

i instantly

Step 08

Light and color

if high

2o with red. it can sianify

also affec r emotic

t storytelling toc

2w in step 04

lors can tri

responses
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4 Dominating color here is blue, a classic decision for a, dark look. A cold red is used for contrast I

0O000e0e

A Ag expacted, a bluish color scheme will result in the effect of a cold atmosphere in the image I

/4

A Use dark shadows with angelic white to get the an enigmatic effect, without using blue

O00O00

A This friendly color scheme plays with warm hues, but stays within a monochromatic look

—

4 Main light source is the sun; secondary is the sky, causing the color in the shadows lo look blue




4 With the new cold color, the fish stand in a nice contras!

2. Use “clipping mask"

A Adjustment layer: 1. Click the icon: 2. Clip it 1o the layer you want to affect (Alt+Ciri+G)

Prest

orange light of the evening sun. Note the cool
tint of blue in the shadows? That's actually
light bouneing from our secondary light
source, the blue sky. The holes in the snow
are areas that receive very little light, neither
direct light from the sun nor indirect light from

the sky; as a resull, they appear very dark

Before picking a palette we have to consider
where the light is coming from. Is it natural
or artificial? Is it moming or afternoon? What
are the colors of the environment? Once we
know the light source, we will have an idea
about the colors and their temperature.

However, natural light isn't the end of the
story. If we want maximum effect, we can
bend the physics a bit. Images 08b and
D8c show the use of color temperature

as a conltrasting element in a design. The
golden kight illuminating the character is
not to be found on the fish and rocks in the

foreground in image 08¢, adding a slightly
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Color Picker

A The Color Picker shows you can alter the mask by painting with black or white
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4 Copy your character image layer to get two exact copies
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Mask thumbnail

A Activate the image thumbnail then blur the layer 10¢

Click tf

Next we'll soften the tr

Mask thum the Properiies pai pull

the slider to feather the mask (image 10b). To

y blur to the image, first click the image

thumt of the Mask layer. From the menu

bar, se = Blur > Gaussian Blur

decide on a value. and confirm (image 1

To lower the acl of the blur, simply red

the of of the

the Opacity slider in the Layers panel, or (this

is the more controlled way) use a soft brusk

on the mask to make m

and pa

Make sure you activate the Mask tt

when try

u will paint on your i

4 Close-up of before and after

happen! You can see th :¢l in image 10d
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Character generation

Find out how to use Photoshop tools to create a character.

Now that you have discovered the key tools and theories

behind character creation, it is time to put them into practice.
Bram "Boco” Sels will guide you through a complete character
generation process. Using his own character creation, Bram

will break down the workflow, explaining each setting, tool, and
technique he uses lo develop his design. From using masks to
paint skin and custom brushes to paint hair, to adding background
texture to ground your characler in a scene, you will learn a
variety of methods you can then apply to your own paintings.



Body type and skin

Figure drawing and painting realistic skin textures

by Bram "Boco" Sels

In this section we'll look in-depth at how

to create a heroic 19th-century character

for a video game. It's tailored to concept
artists who are just starting out, as well
as more experienced concept artists
who are looking to hone their skills. The
approach is simple: each chapter starts
with some insightful theory, followed

by an explanation on how to create part
of the character, all leading up to the
polished hero pose in the final chapter.
Need to design just the portrait or the
costume? No problem, just skip ahead
to their respective chapters (pages

88 and 104) and start from there,

By following this step-by-step tutorial
your designs will become more
flexible and you'll be able to quickly
do thousands of iterations of the same
subject without effort. Don't like the
head of your character? Just unscrew
and replace it with a new one. Not
sure about his mustache? We have

a few others in stock for you! We'll

go over all the basics you'll need to
paint a flexible easy-to-adapt character
ready for the production pipeline of
the AAA-studio of your dreams.

And to top it all off, this section is filled
to the brim with quick tips such as
how to use the Pen Pressure toggle to
your benefit, how to create your own

82

A Some really quick anatomy studies, each taking about 5-10 minutes.

textured brushes, how to use the free
PaintersWheel palette, how make your
character feel gritty by applying the
Noise filter, and how to conjure mood
with custom fog and particle layers. My
fingers are tingling to get cracking!

"Your painting techniques
quickly improve if you do
some studies every day”

Step 01

Warm-up 1.0

When | start on a new piece | almost always
do a warm-up first. This is a step that a

lot of beginner artists are templed to skip.

Mainly because they feel it's a waste of

time and working on an epic environment or
character is so much cooler than doing small
anatomy sketches or perspective studies. It
is, however, a step that | feel is absolutely
necessary for two impaortant reasons

First and foremost, your painting techniques
quickly improve if you do some studies every
day, and it broadens your horizon a lot

too. It forces you to paint different subjects
in rapid succession, leaming something

new with every session. Second, though
warming up seems like a waste of time
when you have a deadline coming up. a
good warm-up makes you paint faster and



4 Adonger study of around 30 minutes

mare fluently, so you'll regain that time (and

even more) thraughout the rest of the day,

Step 02
Figure studies

Every an-school student goes

rough figure-
study classes. The reason for this is that the
human body is often the main focal point

of an illustration and is very hard to m.

We are constantly looking and interacting
with other humans, so our eyes are lrained
to quickly detect inaccuracies when we
see a human body in a painting. The good

news is that it's just a matter of prac

When you do figure studies {and you can't
do enough!), you start to notice how light
impacts the body, how muscles connect
and how perspective and foreshortening
change whal we see of the body. Practice
every day and you'll get better in no time.

Image 02 took me around 30 minutes

Step 03

The human machine

Of course, the human body is different for
every person, bul a reigning theory in art is
that it all starts from a perfect base - an ideal
bady that can be modified to create different

body types. So following that theory you start

e
- (P

& A blueprint of the perfect body. Really focus on how body parts are positioned around
the center ling

out by learning how that perfect body works. ideal body is made up of 7

were are different approac

25 lo doing that when you draw the he you can quickly

but ¢

e of the more famous ones is that measure where the feet should be. The

of Andrew Loomis, an influential American crotch is exactly in the middie of the body

illustrator, art instructor, and author, and the bottom of the breasts and knees

are in the middle of their respective halves

Part of this approach involves measuring The body is also three heads wide and

body parts against each other in order to the shoulders :

crotch shoulc

get proportions correct. For instance, the

imaginary triangle that goas

* PROTIP

Pen Pressure

Photoshop CS6 and upwards comes
with som ol new brushes that
t for digital artists. Th

S mimic how actual brush

Tilt your stylus and you'll get a fiat line

push hard and you'll get a fat line. Nifty
When you h:
ting, you pre
the m

it, which is

4 Using the Pen Pressure toggle for opacity gives you more control aver your brushes
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4 An easy-lo-draw skeleton and how it translates to different body types

Step 04

Imaginary her

Up until now the only thing we have done
is study the perfect human form and how
it's translaled to a drawing, but whal if you
don't have an exacl reference for what

you want to draw? As an illustrator or
concept artist you should be free to draw
whatever you can imagine. so copying a
reference 1:1 will get you nowhere. (Unless
you have a bearded dwarf or an alien
locked up in your basement, that is.)

Artists often have to draw bodies for which
they don't have a reference, so an easy
alternative is to start with a shell that looks
like a human and for which you do find a

* PRO TIP

Lock transparent pixels

When you're working on a ¢l

ter, masking is 3

reference. That “skeleton” is easy lo draw,
can be moved around and posed without
much work, and afterwards you can draw
whatever you want an lop using your
{human) reference as a guide. Drawing

a small muscled dwarf for example?

Just broaden the head, ribcage, and

hip, and move them closer together.

Step 05

An ancient Gree

Around 500 BC the Greek sculptors became
masters of anatomy by studying the ideal
body and creating millions of sculptures
toits likeness, They almost always placed
the weight of the body on one leg, making
the sculpture a lot more dynamic. Compare

Iways one of

the first things you should do. Basically it means you paint the

silhouette of the character you're working on a

use it as a stencil

Create a layer below the line art to act as a mask and in the

top of the Lay
which bl

lette you can lock transparent pixels

s off all pixels in that layer that are empty (in other

words, everything outside the silhouette). Now when you're

painting you don't have to mind the size of the brush you're

using, since all paint will stay neatly inside the mask

& Masking out the silhouette of a character can really speed up your workflow

84 Beginner's guid

& The ideal body, leaning on his right leg Im

this body to the blueprint of the body in
image 03 and notice how the entire body
language changes. even though it's based
on the same blueprint. Closely study how
the muscles group and how the center of
gravity slightly moves towards the left

"A body with correct values
but wrong color still looks
okay, but a body with
wrong values quickly looks
anatomically incorrect”

Step 06

Key light/back light

Trying to figure out how to light a body might
feel difficull and overwhelming at first, but it




4 Defining the light scheme on a little ball helps to organize things

becomes a lot less daunting when you go
at it one step at a time. A great tip is lo start
out in biack and white. That way you can
focus on the values without being distracted
by the color and temperature of the skin. A
body with correct values but wrong color still
looks okay. but a body with wrong values
quickly looks anatomically incorrect.

Another greal trick s lo define the lighting
scheme on a ball before starting on the body
A common lighting scheme in concept art

is with a key light (the main light) from the
front and a rim light (back light) from behind.
Note in image 06 how the muscles react
almost the same to the light as the ball

Step 07

The body as a whole

Keep in mind that the body remains a volume
initself. See it as a giant cylinder and think
about how that giant cylinder would react

fo the lighting scheme you defined in step
086. I's nol enough to define every muscle
according to the lighting scheme; you should
also keep in mind where those muscles are
on the body. If they are on the light side of
the “cylinder”, they will of course be lighter
than the other side. This is most clear in the
biceps of both arms. The right bicep is on the
light side of the bady and s almost entirely lit,
while the left bicep hides in the shadows of
the chest that sticks out and blocks the light.

Step 08

Highlights, midtones, and shadows
After adding in the basic values, try to define
a color scheme, Different lighting conditions
have a different impact on the body, but for

this study we're keeping the light neutral

so the skin tones will be fairly neutral as

well. Caucasian skin tones often range from
purple to deep red, to yellow and even green

When you look closely at a person’s skin
you'll see that there's a lot more information

& Defining the skin colors; the arrow points towards the main wash

& The value block-out for the body

there than you might expect. Still, it's best

to define some common skin colors at first
and start from there. | usually change the
painting mode of my brush (you can find that
in the Options bar at the top of Photashop)
to Color, and give the entire body a color
wash; in this case a warm, orangey tan.
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Step 09

Color zones

Often skin

a 1ain colar ¢

colors. O

mes easier (o notice

dict how the

& light

1 the body, skin

re red

lones will gradually become m

e than they are around the ch

O

Il be more yellow and

You can espeacially see this in

the

ands. knees, and feel. This has ils

act an the shadows a

vell, resulting in

purple shadows in those areas and

i
s
i
s
b J
s

warm shadows around the chest. Look

for some references when painting thes

areas - they will really help

your figure co

Step 10
Refining the body

nsists

The last step in this chapter

refining and detailing. Although you al

defined the values a few steps back, you

1 still keap working on them = nothing

s point. Push the

s sat in stone &

highlights as much as you can and try lo

create lively shadows by introducing vibrant

lors to the darker paris and areas. Take

nce in a while, so you

K to it with a

Ak you nolic

& The body gradually becomes more reddish near the bottom Im

you a fresh perspective

skin texture. Put the layer's blending mode to Soft Light and it's
opacity to 12% — your skin will denly have a lot more texture
ra texture is with Photoshop's

v layer and fill it with a neutral

wing RGB levels as shown in the image o o P Hemraent
25, G: 125, B: 125). Click on Filter > Noise >
d Noise, and use il to whip up a 1( manochromatic noise

Now use Edit > Transform > Scale and then drag to double

the layer in size; this will give you nice big chunks of noise

Click on Filter > Filter Galle! Brush Strok Spatter; then

A Crealing 8 noise layer 1o bland over your skin will cfien give it that exira edge
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Designing and painting the face

Mastering the techniques to create a life-like portrait

by Bram "Boco” Sels
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Portrait painting has been around

for centuries. Before the invention of
cameras people mainly used it as a
means to immortalize themselves, but
with the rise of photography it lost a lot
of its popularity. The reason for that was

that photography could achieve the same y *iq,
effect a lot quicker and thus cheaper, 4 ",:

N

5 b | ]
With the development of concept art, % -
however, methods from portrait painting J X
‘

have become a lot more popular again .
- be it as a way to put existing actors in
imaginative environments or to create A Five head studies from Wiki Commaons, taking around 10 minutes each |m

characters that don't exist in real life but
look so convincing that they could do.

To create such a character it's important
to master the techniques needed to create
a life-like portrait. In this chapter you'll
learn, among other things, how the skull
is the foundation of the head and how

it changes the distribution of light on
the face; you'll see how the direction of
the light can dramatically change how a
person looks and how the face is made
up of different color zenes, You'll learn
everything you need to know to paint
realistic, imaginative faces from scratch.

Step 01
Warm-up 2.0 (the classy one)

02

Just like in the previous chapter, it's A Studying the skull that's on my desk. On the right you can see how it can be reduced to basic,
primitive shapes
important to warm up when starting on a new
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piece. This lime | opened up Wiki Commons
and browsed through their enormous library.
It's a fun thing to do and browsing through
different eras and different subjects expands
your internal reference library each time.

Eventually | stumbled on a set of early 20th-
century gentlemen and decided to do a study
of a few of them. Something to think about
while doing studies like these is how the eyes
«can really define the character of a person
Got to love that facial hair. too — | wish |
could get away with a mustache like that!

Step 02

Skulls are awesome!

Write this down: you should do at least one
skull study each year. Not only is it a cool
subject, it really makes you understand
how the human head works — how the jaw
connects to the rest of the skull for instance,
and how the brow and the cheekbones
define the form of the head. It's a good
idea to get yourself an anatomically
accurate skull to refer to while painting

When drawing the skull you'll start to notice
that it basically consists of a few simple
shapes: a ball with the sides cut off and the
chin as a rounded square protruding from
it. Understanding these simple shapes is
half the battle when painting the head.

Step 03

Lighting the face

Starting oul with the simple shapes from the
previous step, you can construct the rest

of the facial features on top of them. Keep
the facial features simple at first; it will be

a lot easier fo light them that way. Notice

in image 03 how the nose protrudes from
the face and how the eyes are {obviously)
round and should be it that way.

The two lighting schemes on the right of
image 03 are pretly basic but very common
in concept art. The first has light coming from
the top, the other from below. Depending on
where the light comes from, some planes will
be lit while others will hide in the shadows
Always keep in mind how the planes are
oriented towards the light; planes directly
facing the light should always be lightest

4 The line art for the head, trying to create character with the facial features

Step 04

Creating your own character
Inspired by the warm-up in step 01, |
wanted lo creale a face that looked both
worn and rugged. but still appeared
stylish and 19th-century-like. | wanted to
create the main character for a fictional
video game, and chose to go with a
Caucasian, bearded, hero type.

| started out with the basic shapes from
the previous step and once they were
correct | placed a layer on top for the
details. systematically erasing the under
drawing as | went. In this step it's important
to really look al how facial features are
constructed. Look at how the eyes have
ayelids and how they work. Note how the
nose as well as the mouth is divided into
planes that fiow over into each other

Step 05

Masking the face

As with the body, | created a layer
below the line art to function as a mask
The idea is to keep all paint within the
mask and still have the lines on top of it

[ o |

& Creating a mask. while simultaneously I
checking the silhouette

unharmed. Eventually these lines will be
erased and blended with what's below.

Creating a one-color mask will also give
you a clear view of the silhouette of the
head. There's a lot of character in there
as well: the hair. for instance, is slick
and thin and cuts into the silhouette
above the ears and on both sides of the
forehead. The same goes for the beard
and his left eye socket (see image 05)
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"Because the face is often
the focal point of an image,
itis important to get the
facial features just right”

Step 06
Blocking out the main planes

Keeping the same lighting scheme as for

the body in the previous chapter, | started

blocking out the biggest parts of the face

2 put the hair on a separate layer so that

| can focus on it later on. As with the b

out in black and

concentrate on getting the values right

This is the st

where knowing how the fac

jed into planes really comes in handy.

e planes that face the light directly catch
maost of it and will be the lightest. You'll also

notice thal some transitions will be sharp

{like the front of the nose), while others

will be a lot smoother (like the forehead).

Step 07

Refining the face

Because the e is often the foca

L the facial

of an image. it is important to g
features just right. If something s a little off

it will skew the entire character. Get into the

habit of flipping your image once ina

{Image : ge Rotation > Flip Canvas

Hornzontal

you a fresh view so you'll

it giv

notice mistakes in a hear

While you're refining, it's also very
important to gather the right reference

Look at how eyes reflect the lig

ource

how the tip of the nose often catches a

highlight, and how age lines turn with

the shape of t Note that hera the

head will have a lighter si d a darker

side. Depending on the side it will diffs

how the facial features should be Iit

andert

0. | ba

When sically stick to the
same basic round brush and a textured

brush. Using the Opacity Pen Pressure

toggle h achieve some interesti

2lps me

complexities. | often use a seam xture

that | use as a texture in my brushes as

well. It has a convincing grain in it that

works really well to pression of

1 (image
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& Quickly laying in values for the face, keeping the lighting scheme in mind

* PRO TIP
PaintersWheel
PaintersWheel
Photoshop

a free plug-in for
ated by Len White
(http:/lenwhite.com/PaintersWheel/)
It doesn't do anything you can't directly
do in Photoshop, but if's a lot more
accessible than the standard color

ranges your hues in a
circle which is somewhat more logical

pu're painting skin it's a helpful

tool to quickly micro-manage your hues

if you feel your skin is becoming too dull

A Len White's PaintersWheel, a free and very accessible plug-in for Photoshop



& Flipping the canvas regularly can help you lo notice any mistakes Im

 Tatrs Cach T

M —

4 Refining the facial features using settings like these can really give the head a lot more character o7b
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Step 08

The color zones of the fa

When thinking about color, the face can

be divided into different color zones. It all
depends on the color of the light of course
but for Caucasian skin for example, when the

light ig

autral, the top part of the head lends

to be more yellow, the middle part

re
red, and the bottom part more blue/gray

This is especially true with male faces due
to the facial hair they tend to have around

the chin, which has a very

distinct blue/gray

lone. This should be sublle o

a
should not be exaggerated, but knowing

those colors are there makes it easier to see

them when looking at reference photos

A The face is roughly divided into these three color zones
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* PRO TIP

Soft Light and Overlay

The Soft Light and Overlay modes

are traditionally ways to increase the
contrast of what's below. The two most
common ways they are used are by
creating a new layer on top and changing
its blending mode, or alternativaly to
directly change the blending mode

of your brush in the toolbar at the top
of the Photoshop window. The latter
avoids having to creale a new layer,
but is admittedly a little less flexible.

The difference between Soft Light

and Overlay, is that Soft Light uses a
combination of Screen and Multiply
blending, and Overlay uses as
combination of Linear Dodge and
Linear Bumn. Both are valid ways

to boost contrast (see step 10), but
Overlay is the more intense of the
two and thus a lot less subtie




A Mask the area of skin you plan to paint color over

"You'll find the most
intense reds around the tip
of the nose and on the top
of the cheekbones”
Step 09

To tone the face, | created a mask over

the a of

skin | wanted to paint (see

image 08a). | then started out with a

hin the same color that | used for the

body in the previous chapter. After that

my brush on

) 259

| kept the painting mode

Color, but ct ad the opaci

One by one, | ot cked the colors from

the last step and went over their respec

b). Again, look for

some references online and make a menlal

& the most saturated

note of

3. You'll find the most

should be on th

intense reds around the tip of the nose and

on the top of the cheekbenes for instance

Don't overdo it though, or your character

A Applying the color zones on f a brownish base color I- L
pPYing st 05b will quickly lock unrealistic ike a drunk



& Build up the character by adding little scars and irregularities.

Step 10

The head is not a cue ball

at's right, the head is nol glossy and

on his cheek and nose

to get some

pro tip on the
make the age

pop and to polish up the

making

appear mora lively.
the forehead shoule

that the overal

e tool. set to Highlights. It's a ¢

to build up values and to get v

The scars
-hanges in the midt
side and a highligh! side. Using the text
brush means they fit in nicely w
the skin, It's im
be praservec

forat

28
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% PRO TIP

Brush texture
Another way to get some exira texture in
your skin is to work with textured brushes
If you open up the Brush palette you'll

e an option for Texture. In this case |
used a texiure | created from a watercolor
painting. | felt that the rough texture of
the wet paper had some really organic

bumps which could fit well on human skin

There is, however, a lot of greal
and usable presets already present
in Photoshop you'll quickly find
something that fits. It's a technique that's
usable with every brush and on every
subject, so when you | your painting is

king an edge, this might help you out

A Using the texture oplion in the Brush palalte to get some exira bumps in the skin






Painting hair

Techniques for painting hair and creating a brush to speed up the process

by Bram "Boco" Sels

Painting hair might seem very different
to painting a face, but you'll soon
discover there are more similarities
than you might expect. There is one

big difference though, and that is that
hair is anything but static, so it's harder
to predict where and how it will move.
There's no anatomy involved either

50 you can't really measure it against
something. The only thing you do know
is that it follows rules of gravity and is
therefore likely to fall in a certain way.

| used to struggle a lot with painting
hair. | just couldn't get a handle on it
until | started learning about sculpture.
It was a real eye-opener to see how
classical sculptors were able to

render realistic-looking haircuts by
chiseling hair from marble. It drastically
changed my approach to painting it.

Instead of looking at hairstyles as a
combination of individual hairs, | began to
see them as solid forms weaved through
each other. This not only made hair
easier to understand, it suddenly became
clear how hair should be lit as well.

Here you'll discover how to light those
solid forms, as well as how by adding
little specks and hairs you can create
the illusion of the haircut consisting
of thousands of hairs. You'll also learn
how to create a simple brush that can

save you an huge amount of time.

"The haircut alone can
really help define the back
story of a character”

Step 01

Warm-up 3.0 (the stylish one)

During this warm-up | copied the line
drawing from the previcus chapter and tried
some new haircuts on it, just to broaden
my horizon. None of these haircuts made
the final cut (pun intended), but | don't

think it hurls to try experimenling anyway.

For the sake of this tutorial, | quickly
masked out the hairstyles in image 01;
you'll immediately notice how much the
shape of the hair can affect the way
your character looks. The sharp point on

A Five different hairstyles, each generating a different back story
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i Don't think aboul individual strands. but look at the large shape
of the hair and think about how it would react to light

the second porirait makes you won

if he's an evil ma:

voluminous hair and slick must:

of the last one make you th

Casanova. The

"Think about how you
would chisel hair out of
marble and try to mimic
that in your painting”

Step 02
The shape of the hair
Beginner artists often make the mistake of

fividual strands. By

thinking about hair as

thinking about it like this you are te

iculously paint each one, hog

lm A Coloring the hair is a lot less difficull if you make sure your
values are correct

resull in a conving

further from the truth. Hair has

Heck, you

il you like a

f vour

the solic > illusion that it

hape

of thousands of individua

sirands of

Step 03

The color of the hair

Painting hair does not differ from painting

2 that values

g else. in the

more important than color If ntains some sul
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* PRO TIP

How to brush your hair
After you've suggested the bigger volumes of the haircut you can

start by adding the texture it needs. Rather than doing it with a single

brush a thousand times, an easier way is to open a new rectangular
document and pul some more-or-less evenly spaced dots in it. They
should be black and white, differ in size, and have different value:
Now click on Edit > Define Brush Pn Then give your brush
a name and click OK. This will now appear as a usable brush
in your brush library. Open up the Brush (Window > Brush)
palette and in it you can select your brand new brush. In the
Brush Tip Shape menu, change the Spacing to and you'll
have a fast and convincing hair brush. Don't use it oo mu Name: Har Brugh
though; it's better to switch back to single brushes during the

final stages because they lead to a more spontaneous result

A Creating a new brush is a quick and easy way to fill up those big volumes of hair

Step 04

of hair

A maslk
Keeping the haircut on a separate layer
is a good idea when you start laying

in the big volumes. By selecling Lock

Transparent Pixels in the Lay

s 1ab, you
can use a big, soft brush on the sides to
manually creale some gradients. Using
this technique also forces you to see the
haircut as a solid shape rather than a
combination of lots of single hairs, so it will

be easier to shade it as a whole as well

& Masking the hair is great to get some gradients going, but keep in mind that you're not creating a hairpiece!
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Look, for instance, at the shadow under
the nose and behind the ear. By painting it
roughly now, I'll remember to avoid strong

highlights in those parts later on. There is

a pitfall in working like this, however

creating haircuts and nol hairpieces, $

need to remember 10 work on the transition

between the head and the hair, foo

You can change the settings of your custom-
made “hair” brush (see pro tip above) by
going into the Brush Palette to achieve

P -
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A Hair is grouped in locks that are draped arcund the head in different directions

the desired effect. The

xst impaortant
things here are to change the Spacing

o 1% and 10 turn on Shape Dynamics

lo gel Pen Pressure opacity. Turn off the
Size Jitter though in order to keep your
hairs straight and consistent (image 04).
Scattering, Texture, and Dual Brush mode
shouldn't be used here because they will

make your hair feel messy and cluttered

Step 05
Twist and turn
A haircut is mainly defined by how the bigger

locks of hair are cut and draped around the

head. When designing a haircut a good
idea to think about which way the hair is
turning. In this case, the slick hair on top of
the head will be neally combed to the side
flowing over into the beard which will be
mare rugged and chaotically weaved (image
05). Mustaches can be the exceplion and will

often be neatly combed and modeled as well

Use your brushstrokes to suggest the
direction of the locks: try to use large brushes

to avoid the individual-strands-of-hair trap

- [ os |

Step 06

( ra
olor a

eme

The color of a haircut c:

' be a statement

in and of itself. In this case

anted my

character to look a little wiser but still nol too

d to give him dark hair that

old, so | de

started to turn gray. For the beard, | wanted

to give him a sall-and-pepper kind of look

warm dark browns combined with bright gray

and saturaled browns around lhe mouth

You can change the mode of the brush itself

to paint in Overlay in your current layer

houl creating new overlay layers (see

image 06a). You can use this technique
instead of the Dodge tool to boost the
highlights and to sneak in some new colors.
As touched upon earlier, even when painting
gray hair. you should always avoid using
neulral grays. It's better to go for either a

warm gray or a cooler variation (image 06b)

Using different colors helps prevent
the haircut looking dull and unoriginal

and slightly builds up the character

by giving him other

b
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4 Changing the brush mode to paint on
Qverlay in the current layer

A Coloring the beard with a salt-and-
pepper tone
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* PROTIP

Blurring the hair

It's not hard to imagine how hair strands
fall in layers on top of e: other, so

it's a good idea to actually approach it
that way in Photoshop. Create a layer
for the base of the hair and keep on
adding layers of hair on top of that. As

you work from dark to light you should

alzo work from blurmed to sharp.

Blur the lower layers of the hair with
the Smudge tool or with Filter > Blur
ussian Blur. This will reduce
the clutter and give the haircut more
volume. As you go higher up the
hair layers, get crisper and sharper
and top them off with a few extra

sharp hairs going criss-cross over.

A Astep-by-step breakdown for painting hair I

"It's important to work
from dark to light. Start
with the dark undertones
and build your locks on
top of that”

Step 07

build your locks on top pro

brushes (o lay in the

ugh values, and see how it

in locks (image 07)

it pop. set the painting mode of your

brush to Overlay, pick a bright color, and

2xitra shiny high

Every

step

back and see the bigger picture. When the

s individual strands of

4 Using Lighten and Darken as painting modes to pull it all together Im

g something wrong
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"No haircut is perfect,
there will always be a few
hairs running against the
stream

Step 09

erfection

incing if a few hairs stray away from the path



% PRO TIP

Use reference!
The age-old discussion of whether or not a “real” artist
needs references is a redundant one. Millions of artists

throughout history have used references. and to great result

at that. It's not a qu of whether or not you should use

it {you should); it's a question of how you should use it

Basically there are two different ways. The first is to
look for a reference (be it photographs or en plein
air) and make an exact copy of it. It's a great way to

leamn and it's a whole art form in and of itself

The second way, which is used by concept artists all

over the world, is to create something from scratch but

get the right information from the right resources. In this

case, | browsed through freetextures.3dtotal.com for

a hair reference (first image on the right here) collect in it: the way hair flows, how tiny hairs get highlighted
and stick out, the way the hair shapes around the head, and

Notice that the reference is completely different from what | 50 on. While painting | go through tons of these photographs,

was painting, but there's still a lot of valuable information to getling exactly what | need out of each of them

A Use reference photos to your benefit when painting - there’s a lot of valuable information to be found in them

Step 10

Moving the hai
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Designing a costume

Painting different materials to create a 3D feel for your character

by Bram "Boco" Sels

A

Generations upon generations have
expressed themselves through fashion
and that's precisely why concept artists
can greatly use it to their benefit

When you look at someone's clothing,
you immediately (and perhaps even
subconsciously) picture what type of
person it must be. it is a form of prejudice
that can be wrong and hurtful in real life,

but often spot-on in movies and games.

There's a good reason for that: because
of the fast pace of most movies and
games you should be able to take one
look at a person and judge what his

ar her role is in the story. The concept
artists behind the scenes are expertly
trained at communicating this; their job
is to create characters and environments
that speak for themselves, show history,
and are rich with a back story. In the
previous chapter you learned that the
shape of the hair can be helpful in

doing that. The same helds true for

the clothing you give your character.

It is important to remember that every
decision that you make as a concept
artist should contribute to what you are
trying to communicate through your
designs. If your character is a villain for
instance, giving him sharp, dark clothing
will help to reinforce the idea that he is

bad and make him seem more evil.
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Blue boy
scout

]

German
deadhead soldier

A Quick studies of some 19th-century outfits

[ o |

This chapter will take you through

ching costumes
everything you need to know to give from that period. | wanted to create a
your character an interesting costume,
from how to paint different materials
to how to translate that knowledge
into painting onto volumes, to

achieve a lively and 3D character.

Step 01
Warm-up 4.0 (the historical one)

A nt kind of warm-up this time! | had




FABRIL

& An example of one of the patterns and brush texture settings | used

A Three mannequins, ready 1o be dressed

PoliSHD
oos

Step 02

Different materials

‘When painting outfits you'll come across

a lot of different materials. Each material
has a differant color and texture, and reacts
differently to light. While warming up | noted
which malerials were going to return in the

outfit and did a separate study of those

In image 0Za you'll notice that there's a big
difference in values for each material, I've
put the value range in black and white below
each, and you'll quickly notice that materials
like metal and gold reflect a lot more light
than fabric does. Their highlights are
stronger and they reflect their surroundings

a lot more clearly than the fabnic, which has
almost no highlights but does have very dark
shadows. The texture is also different in each

material: some are rough, some smooth

To paint the different materials | used exactly
the same brushes as | did for painting the
face. | did change the pattern in the texture
mode from time to lime though (see image
02b). You can find great textures on sites
such as www.cgtextures.com. To create a
new pattern, download the image and open
it in Photoshop. Then click Edit > Define
Pattern. To get that sleek lighting look for the
glossy-looking areas on the edge of the balls
in image 02a, | used the Dodge and Bum
tools around the edges of the ball masks.
The highlights were painted manually

Step 03

Mannequins

Just like a fashion designer, start out with an
anatomically correct mannequin. Picture it as
a dummy which you dress up the way you
like. It shouldn't be too detailed since itll be
covered with clothes. but it's impertant to get
the big volumes right. If the base is incorrect
it will be very difficult to rectify it later on, so
really make sure the foundation is right

Eventually, | duplicated it so | have three
figures and can therefore create three
entirely different outfits. This way you

keep your mind open and, especially in a
production pipeline, it gives you a few oplions
to show to your client, which is always safer

than coming up with just one suggestion

105



Step 04
Dress to kill
up

It brings v

tume designs, using elements from 15th-century costumes but combining them to
mething new and unigue

4 Thinking about the big values is important if you want to create a character that's readable




Still. all these elements will have to work As a resull, you can see that the ropes
together and support the character n the second jackel beco
more subtle and the emphasis moves

It's important to keep this in mind and think towards the buttons on the coat

about what you want to emphasize and
what you don't. For instance. note that in Step 06

there's a difference between the

image

roped jacket in th

second. In the first | chose to use light ropes you can start thinking about volu

against a dark jacket; in the second | used again. The p

light ropes against a mid-range jacket as in the chapter on painting tt

4 Pushing the values. thinking about the direction af the light and which planes are facing il

% PRO TIP

Using the Histogram

The Histogram s a greal way to keep track of your values. You

can consult it by pressing Ctri+L, which opens up the Levels

pop-u ndow for the layer you've got selected. Altemnatively
en the Histogram palette through Window >

Histogram, which shows you the Histogram for the entire image

What the Histogram does is show you how many pixels of each

value there are in your painting. In the image here you can clearly

see that for my costume layer the curve leans towards the left.

which means I've gol a lot more darks in it than lights. Note that
entirely black (0) and no pixels a

(255). This is an important thing to keep an eye on si

black and white can quickly make an image feel fiat and dull

A Checking the Histogram once in a while keeps your values balanced and alive

first character and in the Once you've settled on |
¥

cess is basically the s

that instead of painting mus:

and wrinkles

painting different r

however, is

same. Think about the body

hat side of the

nman

om there It also doesn't hurt

es open in a separaie

06
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"Depending on the
material you're painti
those highlights and
shadows can differ”

Step 07

Picture it!

tume. Note where light hits hardest anc

% PRO TIP

Photographic textures
Freetextures.3dtotal.com has a great

and free collection of textures that

you can use in your paintings. These
photographic textures can help you get
your materials just righl. Simply look for
the right texture, paste it into your layer,
and use your mask to select the part
you need (Cirl+click on the thumbnail

of the layer in the Layers palette)

If you change the blending mode

of your texture layer to Soft Light or
Overlay and reduce the opacity, your
materials will suddenly become a lot
livelier. This is one of those occasions
where subtlety is key, though. Textures
should boost your painting, not be a

subsfitute for it or an easy way out

A Photographic textures can really liven up your c

h areas hardly




A Pushing the values with the Burn and Dodge tools

"When working in black
and white you don't

have to worry about
oversaturating the colors,
so burning and dodging
areas is a quick and easy
way to push the values”

Step 08

Pushing the values




Step 09

Color through history

or of clothing

hanged a lot

2 the cou

of history. so researching

the right colors for your designs can really

nake your chara believable. Think

about what yple dre xd like in the 90s

and Iry to picture a medieval warlord in

se colors, Doesn't work that v

In the case of my 19th

the recurring colors from that pel

navy blue

colors in mind and a brush

pe g mode

on Color, | quickl

maore round of detailing with a regular brush

Step 10

We have a winner

e | settled dow

on the secc

igures. | felt his double coat ¢

ed jackel were th ymbina of

ee and | liked tF e-colore

combined with the dirty

ts. | wasn't to

sure ak

ich | felt was better

ied that part and

pasted it on my new champion. Lastly | gave
the costume another round of detailing and

ishing

| felt it was ready (image 10}

ants

% PRO TIP

Color noise

If you look at most photographs up close you'll see they tend to have subtie color
discrepancies all over them. Using roughly the same technigue 1o create the noise
for the skin in the first chapter of this tutorial, you can create that great photographic
noise yourself

These color smudges will unify the picture and make the underlying colors feel vibrant

Follow the pro tip steps on page 86, but ensure you uncheck the Monochromatic
checkbox in the Noise pop-up; use Filter > Blur > Gaussian Blur at 92 pixels instead of
Blur More. This way you'll get nice blurry chunks of color thal you can blend over your

painting. In this case, opacity at 6% should do the tri you don't want to overdo it

& Blurred color noise unifies the picture and makes the underlying colors feel more vibrant

4 Using navy blue, ocher, and burgundy as the main colors for the costume

1o






Pose and background

Learn to pose your character and add post-production effects

by Bram "Boco” Sels

The final pose is often just for
presentation purposes. You've already
decided what your character looks like
and you've got the green light for the
outfit. In other words, everything is ready
to go into production and will eventually
start its new life in the game world. A

lot of studios do, however, still prefer to
have a nicely shaded mood painting of
the character as well. It combines all the
elements and gives them a nice image to
use for promotion. Preliminary sketches
and designs like the ones from the
previous chapters are great and helpful
for a 3D artist to move forward with,

but can't be used in marketing. Hence

the last step: the polished hero pose

The main difference here is that the focus
lies more on how you light the scene

and which mood you wish ta convey.

In other words, your character should
almest be swallowed by the environment
around him. This chapter will teach you
how to create fog and particle effects

to do just that. By smartly using light

and color you'll quickly learn how to

create the illusion that your character

is really standing somewhere.

n2

A Quick gesture studies with the line of action going through the middle

nimum you need to get of &

And if you de

notice that one line in parti s chapt

y character

the absolute ki line of gin starts with a bask

o and is




A Building the foundations for my ¢
ki slightly bent, hands a musket

"You can’t build a house
on crooked foundations. If
your mannequin is off, yo
end result will be too”

it | often

A The mannequin di

* PRO TIP

Painting fog
Step 03 Volumetric fog is a natural phenomenon that's
Translating the design used by a lot of concept artists to create depth
in a painting. By placing something both in
front of and behind a character you make
him or her part of the environment. You can

creale custom cloud and fog brushes to use

Keep in mind that fog is so organic that it's
impossible for two parts of it to look alike and
by using pre-made brushes you're bound to
end up with such copies. You can counter
that problem by quickly blocking the fog

out with cloud brushes, but then heading
back in with a regular soft, round brush and

erasing and smudging the repetitive edges




& Most body parts can be seen as cylinders, to which it is easier o apply the rules of perspective 04

Step 04

Perspective

Something that is often forgotten by beginner
arlisls is that even characters have to abide
by the rules of perspective. Even though

you might not see the obvious straight lines
moving towards a vanishing point. it doesn't
mean that perspective doesn't apply.

Think about every body part as a cylinder
and try to figure out how it's oriented. It's
a good idea to draw a horizon line on a
separate layer as it helps you put your
shapes into the context of perspective. In
our case, the most obvious cylinders are
in the boots; look at how they are below
the horizon line (image 04) which means
we see the top of them. Knowing this will
help you to visually calculate how the
beots should appear around the leg

Dragging and dropping a layer on the
Create New Layer button at the bottom

of the Layers palette quickly generates
duplicate layers and keeps a backup hidden
underneath your new one. IU's a good

idea to keep backup layers so you can
always go back a few steps if needed

Step 05

The final mask

For the final image | decide to mask every
element of the outfit on a separate layer

“Waistcoat®, “Skin”, “Coat”, “Pants & Jacket”,

and “Junk” for things like the musket and
boots (see image 05). Keeping elements
on separate layers gives you freedom lo
fluently paint on the layers below, and you
can quickly use the Burn tool to darken
the iransitions between different pieces of
clothing without affecting what's on top

hannet

A& Masking everything onto separale layers

| had decided | wanted to create a
dramatically backlit scene, so as a first
step towards this, the Light layer above
the layer stack is an Overlay layer that
brightens the top of the image

Step 06

Detailing the face

Atrap I've fallen into a lot before is detailing
the face just as much as the rest of the
body, marking the place of the eyes. the

tip of the nose, and the line of the mouth
without worrying about the rest of it. That
way a lot of sublle information goes out

the window and these gaps need lo be
made up later on. | feel it's much better to
zoom in a bit and really plan the portrait out
in advance. It's more manageable when
you have a very specific face in mind, and
it will save you a lot of time later on



% PRO TIP

Color adjustments

Adjustments can be made directly into a layer through
Image > Adjustments, but can also be made via an
adjustment layer, which you can find directly above
the Layers palette. Working with an adjustment layer
does create another layer, which will clutter up your
file, but on the positive side you can toggle it on or

off later on. This means you can always change the
settings later on. Color adjustment layers allow you to
experiment with color and tonal adjustments without
permanently modifying/changing the pixels in the
image. In this case | used a Color Balance layer to
make the entire image coherent. The color options
you can see in the image here map an existing
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the color changes unified. Color Balance can also be a great

range of pixel values to a new range of values, which helps keep way to get some extra color in the shadows and highlights

lor Balance adjustment layer, an easy way to unify the colors in your painting

4 Planning out the facial features for the portrait




Step 07

Changing the

hting

| wank ) create a more dramalic &

foreboding environment, so | had to

change the lighting scheme somewhal
d

the back light and moved in some fog to

To gel that dramalic

ibe | incre

disconnect him from the background

To paint fog, | create a brush from a cloud

photo/texture. Do this by opening a cloud
photo (it can be one you have taken yourself
or from a free texture site), and, using the
Lasso Tool, select an area of the image from
which you want 1o make the brush. Right-
click the selection and select Feather to

about 20 pixels. This blurs the edges. Then

copy and paste onlo a new

‘We now want to desaturate

Adjustments > Desaturate (Shift+Ctri+U),

Add a Levels adjustmenl layer and maove the

sliders until you end up with a blacked-oul
background. Next add an Invert adjustment

layer (Layer > New Adjustment Layer >

Invert). You should be left with a nicely

cloud, so choose Edit > Define Brush

and you now have a ready-to-use brush

Returning to the figure, | blocked in the
values, looking closely at the images from
the pravious chapters to make the final
illustration as consistent as possible. You
might be templed to copy parts directly
from your previous designs, but | feel

it's better 1o just paint them again from
scratch. It'll be more correct and you'll have

more control over whal you're doing

Step 08

Cue the dramatic music

If you're creating a mood piece like this it's
important to think about the color scheme. |
knew ihat | wanted it to be cool and dark to
get that tense vibe across, so one of the first
things | did was darken the background and
tone it blue. | also started toning each part
of the character in its local color (the color il
has under neutral light). It's imporiant to note
that color changes when under a colored

light, but | wa

ted to gel the local colors as
close to the original designs as possible

before worrying about the color of the light

[}

* PRO TIP

Particles

Adding particles is another
fantastic way to liven up an
environment. Be it snow, rain
fire embers, or in this case
dust, it makes you “tasle” the
atmosphere a grainy photo
of a moldy brick wall and placed

it on top of the layer stack with
its blend mode on Color Dodge.

| reduced the opacily and erased
the particles that | felt got in the

way of more important elements

| think that after erasing, only

about 20 percent of the particles
remained, which was just the

right amount to keep il subtle.

4 The dust texture | created from a photo of a maldy brick wall






"Some artists just starting
out may be tempted to
throw over an adjustment
layer at this point and call
it a day, but that should
only be the starting point.
Your lighting becomes a
lot more accurate if you
take the time to go back
in and touch up your new
colors by hand”

Step 09

Grounding th

or the platform

f a cobblestone road

> Perspective

Step 10

Pushing the r

18

& Creating a platform and cast shadow can really ground your character









Creative workflows

Learn how to create different styles of characters in
Photoshop by discovering the processes of top artists.

With the many different approaches and technigues accessible in a
program as powerful and versatile as Photoshop, many artists have
adopted signalure and unique styles. Part of growing as a digital artist

is crafting a style of your own and over time you will soon refine your
own lechniques. To help you on the path to developing your own style, a
seleclion of talented artists. with a plethora of knowledge to share when it
comes 1o digitally painting characters, are on hand to guide you through
their creative workflow. Each artist will talk you through their complete
creation - from initial ideas fo the technical process — sharing their tools,
methods, lips, and tricks, which will encourage you lo find your own style



Desert man

Create an evolved human designed for living in the desert

by Derek Stenning

o Sveie i

¢l Tt

In this chapter we'll go though
the steps | usually take to create
a character design for a client.

The assignment for this design is to
create a character that has adapted, or
evolved, to live in a desert environment.
The design brief is pretty strict, in

that even though the character has
evolved, the character must remain
human, with two arms, two legs, and

s0 on. This means the evolutionary
changes won't be too drastic, but

they will (along with equipment and

5

To warrant the need for these
evolutionary changes, we won't be
using any high-technology solutions

to the challenges posed by the desert
environment; we'll keep it fairly low-tech.

An important thing to look out for in

a brief is a scenario or story. When
design assignments don't have a
scenario aspect to them | usually make
one up myself, as it is a huge factor in
making design decisions — what is this
character doing in the desert anyway?

i I ) help the ct
cope with the desert environment.

Challenges of a desert
environment

Unseen:

Aestivation ysa inis

for this 1t will be no

My p
different, so I'm going to imagine that the

Covered clothing:
« Block out heat and 3un

»Robas, tayers.

» Light in color 10 reflect heatirays

Mot going i Noctumalcrepuscular

heat | Inereased mobility:
» Aids for traveling in sand, loose

Behdiitia | f__ Extremes of
e temperature
L:calt‘egf ) Covered clathing:
AR, | Dissipating  « Light in color to reflect heatirays
water / g iz

Moisture trap

+ On staff andor body?
Ground water pump

» On siaff?

Stores carmied on body

Evolution:

« A mewe o darker skin

» Longer kmbsbidy ko allow more
heat loss

« Increased shoukder widt 1o allow mom
airflow and h
body. Same for hips?

= Larer eas o dliow heat 19 escape

4 Collecting the various design problems in this assignment and thoughts on how to address Ihem’m
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character is some sort of scout; maybe he
is tasked with patrolling the vast desert
boarder areas of the society or group that
he belongs to. This task will require him
to spend extended periods of time out in
the desert alone. Even though his people
have evolved to be better able to cope
with this environment, the scout will have
to be equipped to carry out his mission.

Step 01

Character and environment research
| always start my designs with a little look
into the subject matter. I'm no expert in
evolution, or in desert environments, so

a little time spent learning about those
major elements for this assignment

could go a long way in informing my
design choices for this character.

| look inte the challenges of living in, or
adapting to, a desert environment. The major
issues are the extremes of lemperature

& References are a great way to inspire



Brow:
Large brow to protect eyes

“. Mouth:
Smaller mouth, with litthe or no lip
helps retain moisture

Ear:
Enlarged ears allow heat
1o escape the body

.‘\

Eye:

A large brow and darkened eye
wells help protect the eye from
intense light

A nictitating membrane helps
to protect the eye and retains
moisture

\=F ki
P s | ]
N e
N~ 3 \
\, A
Nose: 2

A flattened nose with nostrils that can
close helps reduce evaporation and
prevents moisture from escaping

A A sketch of potential evolutionary changes 1o adapt to a constant desert environment

(hot in the day, cold at night), and a lack of
water. To address the temperature issues,
I'll have to find ways for the character to
avoid and dissipate heat in the design

I'll also have to find a way this character
can retain or acquire water. The desert
can be a hostile environment, so that will
have to be reflected in the design. | lake
all my notes and collect them on an idea
map for quick reference (image 01)

Step 02

Image reference gathering

After taking time to think about the design,

| spend more time gathering images that

| think can inspire me or introduce me to
new ideas. References help to expand your
thoughts en a particular idea, so | search
for what | think are fopics related to the
assignment at hand. | collect images that
strike me, or contain something that seems
1o address a part of the design concept, and
put them on a reference sheet (image 02).

| limit my time doing this as | could search for
reference images forever; I'm only looking

for little bits or elements that contribute to
the design, not for the perfect image.

“I'm keeping the body long
and lean, as this will allow
for less heat retention and
increased heat dissipation”

Step 03

Evolution study

The brief states that the character has
to remain human, so the first step in this
design is to figure out the evolutionary
changes to the bady that have occurred
for it to live in this desert environment.

| sketch these ideas out, as | find that it
moves things a little faster than painting.
In Photoshop | use a simple round brush
with pressure sensitivity set to around
10-15% and opacity set to 50%. | lightly
sketch out a few of the ideas that came
ta mind after putling together the idea
map. | sketch these ideas out loosely on
a layer, and once I'm happy with them, |
then tighten them up a bit on a new layer,

Body:

The slender elongated body
allows for less heal retention.
Wide shoulders allow for
increased airflow between
the body

Pigment:

Darker skin pigment helps with
the protection from high UV
radiation. Here. for visual interest,
I've broken up the darker pigment
areas 1o create fades and spotting

Oi

adding a bit of quick shading to help define
them and to give them a little “pop”.

As it is early in the design phase and since
this material is mainly going to be used

to create another design, these sketches
don't have to be too final or polished — they
just need to communicate the ideas.

I'm keeping the body long and lean, as
this will allow for less heat retention and

ased heal 1. Wider
sel the arms away from the body and allow
for increased airflow and more heat to

escape. Darker skin pigment, in image 03
broken up into spots and fades for visual
interest, aids in protection from UV radiation.

On the face. a heavy brow, darker eye wells,
and the re-introduction of a translucent
nictitating membrane protect the eyes from
UV radiation and airborne debris. Larger ears
facilitate more heat loss and a smaller mouth
decreases the loss of moisture. The nostrils
have gained the ability to be open and shut
when breathing to conserve moisture.
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Step 04

Silhouettes round 1

lighten these

did earlier

2 on its own layer sat to 15

acity), so l'll kn thin

original proport

esert expanse

Then | rough out some lo

s on the silhc

is and id

image 04b)

ng over these

brush set to 1

4 A quick pose sketch
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& Filling in body farms: I A Filling in the interior of the clothing [
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A Lighlening the areas further away
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A Painting the rifle in profile

A The final silhouette
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Moisture
trap

Armar

Musket/
staff

Water
cistems

Robes/
shelter
Carapace
shelter

Louvered
gamant

Cleats

A As you can see, silhouettes explore design options in a quick and efficient way

125



Step 05

Silhouettes round 2

We'll now narrow our options down by
choaosing our favorite designs and modifying
them, with the addition of new ideas or
elements from other opticns presented in
the first round. In a production environment
this would be done using feedback from the
art director, but here | let my own thoughts
and preferences guide the process

To put these together you can cut up the
silhauettes using a selection tool, such as
the Lasso, and mash elements together
Alternatively you can paint elements over the
silhouetles from the other existing silhouette
options or new ideas that come to mind

My first selection is option 7 from the
sllhouettes in image 04j as | really like the
simplicity of it and it seems to communicate
the desert scout theme to me. But | really
like the signal silk from option 5. so | paint
in a similar version and also add the signal
reflector lo his staff to aid in his scout role

| also paint in water collection bladders
from option 5 along his sides to give him
some more water retaining/creation ability.

My second choice for further study is option
1, as it also seems to sum up the character
The only additions | make to him are
extending the armor elements and adding
some armor to his right arm as in option 4

but in a much more restrained fashion

4 Painting in mid-gray tones
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A Skelching details over the silhoustte
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Step 06

Grayscale rendering

The next step is to take these two
designs further — to block out the interior
costume design elements to see how
they work. This is done in grayscale as
this can be a faster way 1o render up

a characler as you don't have to worry
about color - you can just focus on the
costume/body elements and values

To get started on the grayscale
rendering | first sketch out some interior
elemenls on a layer over the silhouetle
to guide the painting (image 06a).

The lighting will be coming down from the
upper left. To help indicate this and to get
the rendering started | take a mid-gray and
use the Radial Gradient tool across the

upper left side of the character (image 06b).

Then using an angled brush, set to 50%
opacity and with pressure sensitivity on, |
do a quick rendering pass over the whole
character, defining the major forms and
keeping lighting and materials in mind
(image 06c). | also use a cloud-like brush
and on a separate layer, fill in behind the
characler. This will aid later in rendering.

A A quick render pass over the whole character

| now start rendering up individual elements
(image 06d). The headdress is a major piece,
so | start with that. An important thing to
keep in mind while rendering is the material

of the object you're painting. This will affect
how the light is absorbed, reflected, or
plays across the surface. The outer shell

Is a worn metal, so it will be well used but
it will also reflect more light than the dark

wrapping around the characler's arms. | start

by giving it a little texture to indicate wear
by painting in some variance and marking
with a couple of abslracl shape brushes.

Then with the round brush | paint in the
panel cut lines (image 06e on next page). |
keep these on a new layer above the main
painting layer, so | continue to paint in the
lighting and texture information without
obscuring these cut lines. As | said, while
this is older, more worn metal, it should still
be reflective, so | decide to paint in more

[
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A Rendering individual elements

% PRO TIP

Presentation

Remember that concepts are about

communicating ideas, and you can
your i etter by

adding a level of presentation to

your work course, a good d

of skill is the most important part of
creating a good presentation, but you

your conceplts stronger

by ciearly labeling them, following

nventions, and including

additional thoughts and information
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& | repeat the process over the whole character

A The resull after grayscale rendering was used to further explore design options Im
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colors

4 The triad color scheme
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4 | use an angled brush at 100% opacity Im

Step 07

Rough color compositions

After the characters have been blocked out
in grayscale, the next step in this exploration
is to add some color to help us evaluate the
designs. Color is important, and using an
Overlay layer in Photoshop is a great way

to quickly add color to your rough work. I'l
explore a couple of different color schemes
across the two designs and judge the results.

On the first character, I'm going to use

a pnimary friad scheme. Triad schemes
use three colors that are evenly spaced
around the color wheel (image 07a), This
method creales color schemes that are
quite bold, even when using subdued
hues, as | tend to do. As | want the heat
to come through on these characters,
I'm going to use red as my anchor color,
with yellow and blue backing it up.

130 Beginner's

Triad color scheme

Atriad color scheme uses colors
that are evenly spaced around
the color wheel. Triadic color
schames tend o be bold even if
you use subdued versions of your

Itis best to let one color dominate -
and usa other two colors as =
secondary/accent colors.

guide to digital painting in Photoshop:

A | tweak and balance oul the colors

Once we have our color scheme sorted

| create a new layer set and change the
blending mode of the set to Overlay (image
07b). This will allow me to use, sort, and
change multiple layers for different colors
over the grayscale image. | want the hot
temperature to come through on these,

& Creale a new layer under the character and pai

Characters
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50 on a new layer within the layer set | fill
in a red color over the entire character.

| then go over the character, painting in the
diffarent colors for the different elements

| create new layers as needed for the
different elements. This just makes it easier

int a background



CRannel AGE

A Adding in the secondary details 4 Levels adjusiment layer lo alter contrast I

| o7t}

to modify and change the colors as you go | then select the character and create a
For the painting I'm just using an angled

brush at 100% opacity (image 07c)

Levels adjustment layer. | tweak the levels,
punching up the contrast by increasing

the lights and darks (image 07g)

When the major elements are all filled

in | spend some time tweaking and
balancing the colors (image 07d). For this
| often pick a new color and paint over

Finally, in order to warm it up a little.

I select the character, and then on a
separate layer | fill my selection with a
the specific layer, but | also sometimes warm, lighter-toned orange | grab off the
character's shadow (image 07h). | then
set the blending mode of the layer to Soft

Light. As the fill color is lighter than 50%

use the Hue/Saturation or Levels
adjustment panel and tweak the existing
color until | find something that works.
gray, this will lighten up the whole image
After the colors are where | want them,
| create a new layer under the character
and paint in a simple background for the
character to rest on (image 07e). This
was painted with a cloud-like brush and a
texture brush to give it an abstract random
feel. This background helps the “pop” of
the page and will aid in the detail pass.

| now do a quick detail pass on the
character. On a new layer on the top of
the layer stack, using an angled brush
wilh pressure sensitivity on and set to 50%
opacity, | go over the character adding
secondary details (image 071). | also paint
in some reflected lighting using the colors
from the background 1o give the characler
maore volume and depth. As this isn't a
final design, you don't have to go too far
with this detail pass, just get the image to
a point al which the elements are reading

and you are comfortable presenting it & Exploring prseibje: dolor cpfions

4

A Wash the character with a warm orange I 0

and wash it in the subtle warmth of the fill
color. | pull the opacity back to around 40%
50 we are lefl with a warm, hazy feel

kind of like you would expect in a desert!

| repeat this process on the second
character, this time using an analogous color
scheme (a color scheme that uses colors
that are next to each other on the color
wheel: see the nght-hand figure in image
07i). | start with the same red base, but move
into violets and indigo as my secondary
colors, and add a bit of orange for an accent
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Step 08

Creating the final design

After weighing-up the two designs, | decide
to move forward with the first character
option. This version seems to hit more of the
design criteria: the loose, layered robes and
the large headdress (which I'm imagining
will fold out into a shelter) help to block out
heat radiation: the moisture trap, that collects
moisture in the water bladders, helps with
water retention: the foctwear increases

the sole surface area; and the staff will

aid in traversing the loose, rough terrain.
The signal staff and the signal silk (one of
several carried) help this scout communicate
across the desert expanse as well.

I'm also moving forward with this design
because it has more emotional impact,
and hits on the solitary, somewhat
mystaricus nature of the desert scout.

Now that I've made my choice. | refine
the characler a little more to bring it up
to a presentation level. | start by taking
the color composition and merging it
all together, except for the background.
Then | make a few larger changes.

First | adjust the position of the signal staff,
bringing the heavier front end down. This
looks more natural given the weight of the
signal end of the staff. Using the Polygonal
Lasso. | grab the staff and free transform
itinto a downward facing position.

& The chosen character option is refined

2 Shelter

1 Supplies The targe headdress unfolds into a small single-person shefter, This shefter

3 Signal staff - reflector mirror

The signal staff has a mirror with a hinged
swivel cover. This mirmor is used 1o reflect
suniight o creats communication signals o
other scouts. The swivel cover can be used
1o interrupt the reflected kght to creale signal
patiems or Morse-code-like messages.

Carried on the back, this parcel contains: a

ceramic vessel that carries food and doubles

a5 @ slove, four additional signal siks (in four
different colors), and bedding

. Belt attaches here

s used to avoid the hottest periods of the day, 1o bed down for tha night, or ta
provide protection from the desert storms. The staff is separated in two. with the
botlem porbon extending to bacome the main support for this shelter

4 Detail sketches are a quick and easy way to flesh out elements of the design lm
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Second, | erase the large signal silk to the
left of the character. | want to give the image
more depth, 50 on a new layer under the
character | paint in @ new a new signal silk
that extends back into the background

Now I'll work on tightening things up. I'll
create a new layer on top of the layer stack
and using the angled brush (again set to 50%
opacity) I'll paint in more lighting information
and add secondary details such as the

litthe weights that keep the robes in place

and the staff details. During this process

| also rework the background with the
addition of a patch of dry, cracked ground

Step 09

Additional design details

Now that the final design is done, I'll
create a few skelches of additional
design details. These quick sketches will
help flesh out elements of the character
design thal don’t come through in the
image from the previous step and
communicate additional design ideas.

If you leok al image 09, these include a detail
of the supply pack carried by our scout. a
detail showing how the large headdress folds
out into a shelter to protect the character

from the environment (whether from the heat
of day. the cold of night, or a desert storm).
and finally a detail of the signal reflector
mirror that is encased on the end of the staff.

Step 10

Compiling the design sheet

The last thing to do is to compile the design
malterials onto a single page. This will serve
as our design sheet that would be used to
present the final design to the client. | take
the final design render, the additional design
details, and since the facial area is half
covered by the mask of the moisture trap, |
include the head elements from the evolution
study as well, and | arrange all the images on
a page with the relevant notes (image 10).

At this point, if there are no revisions
needed, the design is finished. I this
design were 1o be approved, we would
then move forward with creating a tumn-
around and potentially more detailed
images so other artists could start to
implement the design into the final product.

1. Body: the slender elongated body
allows for less heat retention. Wide
shoulders allow for increased
airflow around the body.

2. Eye: a large brow and darkened eyewell
help protect the eye from intense light

3. Moisture trap: captures moisture from
breath, funnels this down to the water
bladder (worn around back of tights).

4. Signal silk: used to convey
messages 1o other scouls.

o

. Bladders: water bladders are slung
around the back of the lower robes.
Filled before missions and can
be refilled at supply stations.

o

. Head: numerous other features on the
head contribute to desert adaptation: ear —
enlarged ears allow heat lo escape; mouth
— the small mouth helps retain moisture;
nose - nostrils that open and shut when
breathing prevent moisture from escaping

-

Supplies: carried on the back.

@

. Shelter: the large headdress unfolds
inte a small single-person shelter.

o

. Signal staff - reflector mirror: this

mirror is used to create communication
signals to other scouts.

A The final design sheet is crealed to communicate the design to the client

133



Sci-fi female

Design and paint a character surviving in a low-gravity environment

by Charlie Bowater

My starting point for this character is the
theme of “low gravity”; the idea that the
character must have adapted to survive in
that particular aspect of her environment.
My first priority is to find out what the
effects of low gravity on the human body
actually are. Although there’s no way

to know what the effects would be long
term, common side effects for astronauts
are loss of body mass and bone density,
nasal congestion, muscle atrophy,
motion sickness, sleep disturbance,

and bloating due to blood pooling in

the center of the body, Sounds great!

Those are just a few starting points that
could spark an idea for character design. A I'm really just focusing on the general shape of the character at this point (138
Next | want to think about what | actually
want to paint. What kind of colors and
designs do | have in mind? | really like

the idea of taking some color inspiration
from space itself: a very deep, dark
background and some vibrant splashes of
pink and biue to highlight the character.

| also really like the idea of a bit of white
armor, a la storm trooper, to add a nice

contrast to the dark background.

it helps to throw together a mood board
or collection of references to get the ball
rolling! None of them have to be anything
that you have to stick to, but they can

really help with inspiration and remind

A | have a few ideas in mind in relation 1o low gravity; I'm having fun and seeing whal works 02

you of what you originally had in mind.
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% PRO TIP

Keep it simple
I try not to get too bogged down with
too many brushes, Custom brushes

are greal and you can add some great

textures with them, but I'm not sure
how helpful they are when you're first
starting out. I'd definitely recommend
keeping your brushes fairly simple
and honing your craft before you try
using every custom brush that you
can get your hands on. A fancy brush
will never rescue a dodgy painting!

Step 07

& Keep your brush nice and small when painting finer details

& Keep color swalches visible so you can keep refarring back

07




ther well. crack out a color w

& Create matte surfaces by keeping the blending soft



Step 11

Lighting and

m
At this stage | want to build up the form of
the armor and lighting as | go. In order to
do this, | take my regular brush as usual
and much in the same way that | added

lighting to the character’s face, | paint in the

areas where the light will hit the armaor.

You can block this in quite roughly if
needed, but | also take some time to
softly blend the transitions between the
light and shadow. Like in step 05, you can
always lower the opacity of your brush if
you struggle with blending; this way you
can add strokes of paint very softly and

radually, so blending should be easier
Y g

As mentioned in step 10, | want her armor
to appear quite matte and in order to
achieve that texture, | avoid adding any

“shing” to the armor. To understand where

the light is going to hit the armor, | just think

about the areas of her bady that protrude 4 Use soft transitions between highlights and shadows to create form without adding shine i1
further outward, and will catch the light
under her ribs and bust, for example Overlay usually works best — a handy way Ancther option is 1o leave out

to increase the brightness and contrast is o photographic textures and experiment

StEp 12 add in some highlights on an Qveriay layer with different brushes and paintstrokes

A little more lighting and texture along

to emulate the texture instead. Even

setling that layer fo a ¢

Up until now | haven't really paid mask (page 21) = but tr

just a few scratchy marks can read as

much attention to the lower half of the and se

vhich gives you the best result a worn texture when zoomed out

character's body, so | spend a bit of

time building up the form and lighting on

her legs. Her legs are generally going

to be a lighter color than the rest of her
as they're closest 1o the light source.

So. with a lighter shade of her suit, | add
some shape to her legs. It heips to think of
them as a cylindrical shape when it comes

to adding form. They are brightest in the
center of the leg, along the shin, and then
gradually transition into a darker shade
towards the sides of her legs. You can also
add a bright streak of color as a bounce light
on the sides to contrast the darker shade and
to clearly define the silhouette of the legs

To add texture, you can either directly
reference photographs of texture (fabric for

her outfit, as an example) or lay it over the

area you wanl to place it and experimenl with

A Add in some highlights on an Overlay layer and sel thal layer to a clipping mask I 12

different layer options and opacity levels
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A Break the hands down i

Step 13

Step 14

Step 15

% PRO TIP

Experiment with color

If you ever find your color palette isn't quite as harmonious as you'd like, a good tip is
try experimenting with Color Balance. Make a duplicate layer of your painting (Layer

> Duplicate Layers) and then click Image > Adjustments > Color Balance. This can
be a great way of gently tweaking all of the colors in your image at the same time
Try nudging the dials a littie: maybe increase the concentration of blue or pink —
Jjust experiment and see what looks best. You might only need to tweak things the
tiniest bit, but it can have a really big impact on how well your colors sit together







Medieval jester

Concept and illustrate a medieval jester

by Ahmed Aldoori

Research is an important foundation '
for creativity, so | find myself looking at
old medieval paintings as a start. Sure,

| could just copy a jester's costume
directly from reference and call it done,
but that would be boring; we as artists
have the opportunity to take something
and put an interesting spin on itto fita
character. In this chapter we will go from
the development of loose pencil drawings
into a more refined design at the end.

"Even though they won't
all make it to the final
illustration, it's beneficial
to feel that the character
has emotion while you're
designing the costume”

It's important to get a feel for the
character's emotions. | want this jester to
be a sinister type who despises everyone.
He's a court fool, after all. Conveying
this idea is supported by sketching facial
expressions within the design process.
Even though they won't all make it to the
final illustration, it's beneficial to feel that
the character has emotion while you're
designing the costume. Otherwise it will
feel like you're designing a costume
tailored for a blank mannequin.

An understanding of anatomy is a

required skill for this type of de!ign. & | don't render out tiny details early on because loose pencil work can indicate many possibilities I
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& Afew of the many sketches | did in my sketchbook o get a good I & | drew these as small thumbnails in order to avoid getting caught I

understanding of a jester

Without knowing how the human body
works, a cool-looking costume in a still
image could end up completely useless
when it comes to being animated for

human P p k ledg
is also important for this process. | will
be using layers, levels, and blending
options to help me with my design.

"A typical T-pose is an
option but | want to make
this look interesting, so |
go with the more pensive
stance. It's important to
flush out a lot of different
pose possibilities at this
stage in the process”

Step 01

Exploration sketch phase

You'll find a variety of different jester
designs from history. There are extravagant
costumes thal include all kinds of silk and
silver bells, and there are simpler costumes
that appear to be made out of rags.
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up in details. The gesture of the jester is the important factor in this phase

In the skelches you can see in image 01,
I am figuring out different hat designs,
as well as fabric configurations. The
expressions on the faces help me
solidify the jester as a real character

Props are important. too; a lot of the
jesters had some kind of rod with a
mask on i, representing a smaller
version of them, o add to the whimsical
entertainment they provide for royalty.

Step 02

Mare pencil drawing

In addition to using expressions to help
salidify the character, the poses are
important as well. It helps to think about the
character in motion;, in this case the jester
could be performing in front of his audience

In image 02 you can see that I've chosen
to give him an angry look in order to
indicate the reseniment he holds towards
everyone. The evil smile in the top right
can really sell that idea of him being

truly sinister; it's universally understood.
Stay away from anyone that looks at
you like that! On the bottom right | have
made a smaller version of him

Step 03

Pose specific to the final image
Until step 07 we only need the basic

Brush tool with pen apacity turned on

The poses you can see in image 03
have been drawn with the final image
in mind. Whatever the final illustration
is it must showcase the costume
completely for the art director or 30
modeler to understand its concept.

Keeping this in mind, | do my best to

avoid poses that cover up important

parts of the design. A typical T-pose is

an option but | want to make this look
interesling, so | go with the more pensive
stance (marked with a red star). It's
important to flush out a lot of different pose
possibilities at this stage in the process,
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4 The thumbnail beneath eventually fades
away as | repeal this step on 1op of this drawing

Step 04

Pose refinement phase

| lower the opacity of the thumbnail from step
03 and make a new layer on top to draw
another pass of the design. | take the creepy
face | drew earlier and use il as reference for
this. drawn at a different angle (image 04).

For the masked rod | draw a geometrical and
symmetrical frame to act as a placeholder
for the mask to be drawn in perspective.

It's belter 1o lay down a foundation 1o

help guide your drawing. rather than

trying to draw it without a framework.

Step 05

Refinement round two

I do the previous step again on top of the
first drawing pass. This allows for another
layer of precise detail, The main difference
you can see in image 05 is form indication

The jester hat is a complex object s0 it
requires some planning. | have the hat shape
drawn out from before; the form was slightly
suggested, but here the wire-frame lines help
make a clear statement of its volume. On the
floor you'll see a grid sketched beneath him
to indicate perspective. This will ground your
figure so that he seems to be standing on
actual ground rather than fioating in the air,

Once again this pass will slightly fade
away as the next drawing pass comes
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A This pass will slightly fade away as the I“
next drawing pass comes into view

into play. This is a building process, one
step lays the foundation for the next

Step 06

A bit of tone and value

Again, the opacity of the previous step is
lowered. This time | draw in the triangular
patterns on the jester's coslume and

fill it in with value. The value breakup

will help you control the focal point

It's important to be smart with value
placement. If the darks are loo evenly
distributed you will lose movement and focus,
unless having a bland design is the intention
We want this character to stand out. You'l
notice in image 06 that I've drawn the mask
on the side. This was easier to draw on a

flat view, which will be put in place using

the Free Transform tool in the nexl step

Step 07

Transform into perspective

Up until now the only Photoshop toals |
have used are the basic brush and layers
In this step | use the Free Transform tool to
place the mask onto the rod in perspective

Press Ctrl+T and a bounding box will
appear: you can hold Cirl and click and
drag the corners into any perspective
Onee you are happy with the placemenl,
you can double-click within the box or
hit Enter to finalize the transformation

A Still fairly loose here: iU's nol necessary m
to do a perfect line drawing

This is very useful for placing things into
perspective. The Free Transform tool is
also useful if you want lo explore different
proportions of your character. You can use
it to squash or streich him to your liking

Step 08

Masking the jester

Making a mask for your design will make
painting it a lot easier. The purpose

of this is to make a sharp silhouette

4 Using the Free Transform tool



X B
| ! 4 , S= -
4 Using clipping masks might be confusing at first, but once you get the hang of them you will use them all the time. The workflow is faster this way Im

Step 09

Color thumbnail exploration

- warm and cool

Step 10

Blocking in colors

& Even if | choose a color schema, it can be easily shifted using the Im A The Jester's face is also on its own layer to allow me to shift the
Hue/Saturation menu to get more variations. This is shown in step 15 colors of everything else very easily without messing with his face
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round brush to block in the calors in the

clipping mask. It might be helpful at first to
keep each color set on ils own layer: blues

on one layer, yellc on another, and so on

At this paint there is no need to model
or render the forms. Flat coloring will
set the local color for the design, which

will then be manipulated using Levels

adjustments. | recommend avoiding

fancy texture brushes when doing this

Step 11

Lighting an

Here's a secrel method lo help you move
forward very quickly by creating volume and

form. Simply duplicate your flat, blocked-in

bits of color and use Is adjust to

darker. This will make all

"

the shadows equally dark, setting a un

e
- make them 5

value range for all the darks. You then

simply erase oul where you want it to

o go. | use the Airbrush as an Eraser to shine

fight onto the costume. Instead of using just

the Eraser. you can also use a Layer mask

& Using this method is fast and easy. you won't have 1o think about specific color accuracy, the In (see page 78). Both methods work well
right value is already there

Step 12
v Clothing indication and bounce |
— — Clothing has thickness, and s be
sy TR porirayed as such. Once again | use a basic

4 Always pay attention to clothes and the many ways they wrinkle in real life. It comes in handy A Painting some more of the costume’s Im
when you're drawing or painting clothing design elements



4 Creating and adjusting the shadow

| assist you in showing the

Il. | use the Airbrush

This

int a soft light coming from beloy

also helps indicate the cloth’s m

rial

which in this case has

ilky reflectivity.

Step 13

Costume refinement and details

| now paint some more of the costume's
design elements. Jasters always have
interesling palterns and shapes. | highlight

the triangular design language on the hal

y outlining the dark shapes with a yel

line. This could end up being some kind of

| slart painting the face, which also has an

angular language 1o flow with the rest of

the design. | don't want to over-paint the

face since the more imporiant factor for this

There is still no immec

lexture brushes or

xlure ov

The round brush look wi

a preliminary design sl

Step 14

adows in

Becti
p

Here is a neat trick that will make your

character seem placed in an aclual space

Since | already have the silhouette cut out

from the early steps, it will suffice as a semi-
accurate shadow shape. Simply duplicate
the silhouette and use Free Transform
(Ciri+T) to squash everything down beneath

the

aracter (top part of image 14)

You can then paint in a solid gray color onto
the whole thing using the same clipping
mask methods as in step 08. You can erase

away any parts thal do not make &

such as the shadow of his leg sticking out
You can also blur the shadow using Filter =

Gaussian Blur {o have a softer lighting setup

for your character (bottom part of image 14)
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Drop-down menu for individual
color adjustments

® D o icws

& This color-shifting method will work on anything, from props to characters to landscapes. There is no limit to what you can dol Im
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Merchant trader

Use custom brushes to add finer details to your character's costume

by Markus Lovadina

Let's start with a merchant trader
character description: based on a few
hundred years ago, this is someone who
has come from a distant foreign country
and settled in the West. He now runs a
business from a busy trading port. He

is a confident man, unscrupulous and
calculating when it comes to money.

He is intelligent and sharp-witted, with
an eye for detail and a nose for profit
His physique displays his success and
conveys his taste for rich food and

wine, which he has in plentiful supply.

The first thing that came to my mind was
the “good old masters”. Referring to the
old painting masters is always a great
starting point. If you observe some of the
old images you can learn a lot, especially
in terms of brushstrokes, lighting, colors
and composition. This time | decided to
research some Dutch painters, who have
a great sense for color and lighting (as
many others have too). | wanted to go for
a sort of painterly feel. You can find great

reference images by searching the web.

It is very important to start by searching
for references — not only for the design,
but to get a feel for the specific theme
The more | know regarding materials,

patterns, fabrics, and so on, the easier

the design and painting process will be.

& Laying down the first colors

After looking at a range of references



and reading articles regarding costumes the entire | If you're afraid of painting Don't be afraid of playing around until

with the first look

| was ready to fire up Photoshop on a blank white canvas, starl with the you're hapy

background. Thi

“If you're afraid of painting Step 02
on a blank white canvas, y
start with the bac |<gFOU nd” the nvas and will contribute | paint the background with a simple

ok | wanl to achieve round, texiured brush (image 02a), set to

Step 01

und is a go ze and keep the strokes quite loose
gelab a for where the ¢ using Color Balance (see step The main focus for now should be the
hould be v for 15 of this chapter for mo ration) overall color theme and the compasition

Brush Presels

Brush Tip Shape Brush Presets

Brush Tip Shape
¥ Shape Dynamics
Scattering
" Texture
Dual Brush
Color Dynamics
¥ Transfer
Brush Pose
Nose
¥ Smocthing
V' Protect Texture

Wet E e

P Tedure Each T

Build-up
¥ Smocthing

' Protect Texture ; Dt

Mode:  Height

The brush texture settings 02b

[

Angle: O

Roundness: 100%

* PRO TIP making notes. This will help

Research, research, you to save lime later on. It
research! will also allow you to focus
Nothing is more important more on the really important
than research, especially if things during the painting
you have to work on a topic process, such as details,
that is out of your comfort mood, color, and so on
zone or has to be as realistic

and believable as possible. It

is absolutely worth spending

a lot of time researching and

A The simple round brush seltings 02a




be one of your

nitial idea of the

Step 03

Step 04




Step 05

s now separated into sl




great fun, bu
still keep in
th

& The settings for my brus|

g in the first costy

Step 08




Step 09
Step 10

Step 11

A Extra delails add some depth to the character’s story

“This will give a 3D feel
and adds a nice depth,
which is absolutely
necessary to making your
costume convincing”




Step 12

Brush Presets

Brush Tip Shape
V' Shape Dynamics
Scattering
V Texture
Dual Brush
Calor Dynarmics.
¥ Transier
Brush Prse

Nose

Sl

Wt Edges
Buid-up

¥ Smocthing

B BD

V' Protect Texture




"The red stripes on the
trousers bring in a bit more
color variety and portray
his military background.

I also add wrinkles and
more details to the boots
and the costume”

Step 14

Altering the face

A The character's

A The face after | added darker areas to age it

face before aging shadows have been added
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V' Presarve Luminasity v B Luminosity
Teserve Lui

A Color settings for Highlights 15a & Color settings for Shadows

e layer and the

t. Using layer effects

& Color settings for Midtones

% PRO TIP

Create your own image library

One of the most important aspects of my painting workflow is my huge personal
image library. | try to have a camera with me all the time, in case an opportunily
Il channels arises to add to my library. This will be enough to capture a mood, a scene, a

e images 15a

or Bala

color combination; you could use an image as a texture for one of your upcoming
paintings, or even create a custom brush out of it. it's also a good way to study
ill the layers light and materials. And the best thing - those images and photos are all yours.
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Quick ti PS
Discover how to create common elements
used in character design.

Characters are made up of many different elements that all
play a role in the believability of a design. The visual credibility
of these details can influence the success and quality of your
paintings, which can cause problems when you are trying to
paint something that you have never painted before. So, as a
beginner artist, it is useful and important to practice the art of
recreating convincing details and textures. To help you develop
these skills, this section will offer a myriad of approaches and
tips for creating common details and lextures such as skin, hair,
and lace, all of which will help to improve your workflow



Curly hair

by Bram "Boco” Sels

01 Line drawing

Curly hair is mostly characterized by locks of
hair twirling and interlocking with each other.
It's important to lay down an oulline for each
lock. In the example a lock of hair spirals
down and gets pointier towards the end

To keep your curls organic make sure each
turn follows the same direction as the last

02 Masking the form

Create a second layer underneath the line
drawing and use a regular round brush

to block in the shape of the hair with a
solid color. Typically curly hair has areas
of white space around the edges, so try

to create your locks so you can see the
background {or skin) through the gaps.

03 Painting the highlights

and shadows

Create a new layer on top of the line drawing
and determine where the highlights are

with a color slightly lighter than the base.
Wherever a curl is pointed towards the light
(see arrow) a highlight should be there. On
the other side of the curl will be a shadow.
s0 with a slightty darker color than the base.
paint a shadow for each highlight. Locks that
are behind other locks will be darker as well

04 More curls!

Once Lhe larger curls are blocked in, select
a highlight color and start adding smaller
curls behind and on top. Depending on how
curly you want your hair to be, you can keep
on going. To make bigger curls “pop”, pick

a color even lighter than the highlights and
add little specular highlights 1o the top parts

05 Details and over
Use a smaller brush to add extra small
hairs that move through the maze of curls
Work from large to small, so keep these

ay

details until the very end. Make your
colors shine by adding an extra Overlay
layer and go over the highlights with a
big soft brush and your highlight color




Shading hair

by Tim Lochner

01

Use the freehand Lasso Tool and make

a sel n based on your drawing. Now

use the Paint Bucket Tool and fill the

1 with a ¢

selec slor on a new layer, Now

you can use the shape like a stencil/mask

if you turn on the Lock transparent pixels

in the upper area of you Lay:

rs panel

02

Use a soft round brush to a

d the basic
shadows and highlight onto your layer
with the pixel mask. The highlight can

be painted with a simple, horizontal

thick and soft line. The bright rim

he shape a nice outline

031 g [
With a hard round brush you now define
smaller sections using your light and shadow

calars. Use smaller strokes to add smaller

and brighter highlights into the rough

ake is

highlight line. Often a beginner's r
to think only aboul the overall hair texture
Thinking in bigger forms and sections

will help you to create a better result

04

Now you can start thinking about the smaller
details and the texture of the hair. Use a
smaller and sharper brush to paint some hair
texture and detail into the midtones. You can

do the same to highlight areas, but in smaller

areas than the midtones, To add more depth

and realism 1o the hair, add smaller details
and strands to it. Use a very thin and sharp
brush and draw some bright hair lines here

and there. Do the same with dark lines
BB Naisirel K _ To see

Use a brush with hard edges and the this quiCk
Opacity Jitter set on Pen Pressure to ﬁp USEd i!’l a
make the hard edges of the hair ends final Concept.
fade out naturally. Also paint some single go to page

hair tips here and there, This breaks 202

up the hard edges, m 5 the hair look

fluffie

i gives a hint of the siructure



Short hair

by Carlos Cabrera

01 Silhouette

04 Rough up your lines

! s a lot of imperfections

05 Color the hair

ive our base val

To see
this quick
o tip usedina

final concept,
go to page
200
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Straight hair

by Brom "Beco” Sels

01 Laying down the shape

02 Adding shadows

03 Adding highli

r and refining

04 Boostir




Painting fringes

by Bram "Boco” Sels

01

r shape make sure you give it

nd Moves ¢

| think that it always

kly

yaurself by

moves over another

haircut

01

03

05

Wi

\

02

04



Youthful skin

by Bram "Boca” Sels

01 B:

02 Addi

03 Multipl

04 Detaili

05 Noise and frecl




Aged skin

by Romana Kendelic

01 Basic shapes
Re

ence is the key lo realistic depiction of

human skin, so you can study the anatomy,

light, and surface texture first-hand. Block

in the very basic shapes. ignoring all of

Squinting at the reference or even

y in Photoshop can help with
understanding the underdying structures
It is important that the anatomy is solid

before you attempt detaile

rendering

02 Aging skin

When we age. the skin grows thinner
paler, and translucent. It becomes dry.
more fragile, with enlarged pores. It often
(age
The most obvious changes are sagging

develops pigmented spots)

skin and wrinkles. Two types of wrinkles
are deep furrows and surface lines. Also
in very elderly people you may notice that
the face is not completely symmetrical

03 Developing

Wi

N the basic form done, begin adding
deep furrows on the forehead, prominent
indentation on the side of the nose, and

folding of the skin on the upper lid. Do

i draw out the wrinkles. Try to paint
the convex parts, bring out the volume
of the folds and creases. Treat them like

you would a sl

itly squashed cylinder

04 Colors
For the very pale skin, stay away from
b

caolors. giving the skin a lifeless. grayish

i the shadows. It will dull the

appearance. Observe the wealth of hues
salurated oranges in shadows, pinks and
magentas where the skin is particularly

thin on

the lower lid — even pale blues and

violets to acce

ate the lransparency.

05 Finishing touches

highlights for a life-like appearance
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Healed scars

by Carlos Cabrera

01 Choose your scar

Ower a skin-colored base, make the shape of
the scar. Make a seleclion (using the Lasso
tool) or paint freehand. | chose a bullet scar,
s0 | paint a circle in the middle and a cross
cut on it. Pick a darker color than the base
skin tone and paint inside the selection

02 Texturing the shadows

Pick an even darker color using the Color
Picker. With the Polygonal Lasso tool select
where the shadows will be on the scar, every
stitch and skin healed will give you a lot of
texture information, just simplify the shapes.
With the selection made. select an airbrush
or soft brush with a low opacity of 10% and
paint slowly and smoothly over the selection

03 Lighting the scar

Select a hard brush at 5 pixels and 50%
opacity. Experiment with the basic brushes.
Pick a saturated skin color, in this case a
pale orange, and paint the opposite side

of where the shadows are. Remember

to let some of the base skin color in the
middle to emphasize the shadows

04 Sometimes blur is better

Make a round selection using the Elliptical
Marquee tool that covers the entire scar
and hold Ctri+Shift+C then Cirl+Shift+V to
make a merged copy. Now go 1o Filter >
Blur to blend and smooth the scar. repeat
until it's blended together. Lower the opacity
of the layer until the two images blend
perfectly: 50% is a good place to starl

05 Tenture the scar
Select a hard brush (a round hard brush is

: To see
perfect for this stage) set to 70% opacity and hisic k
pick a brighter skin color, a litlle lighter than this qU I_C it
the highlights. Paint with short strokes over tipused in a

the scar, Repeat in a new layer then lower final conce pPt,
the opacity to 30%. In another new layer al gD to page

50% opacity. paint with the bright skin color 200
an the edges of the scar to creale a bumpy

lpok. Use Color Dodge to add the final touch
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Open wounds

by Alex Negrea

01 Line art

With a defaull round brush | paint the line
art, keeping it as simple as | can. | keep
in mind the volumes that are going to be

rendered in the next step, so | draw the

wound wrapping around them properly.

02 Blocking in
| black in the areas that need separation later -

h Color

on in the process. | use a brush

Dynamics turned on to achieve some slight

variation in the hue, value, and saturatio

the skin. To turn on Color Dy

en
the Brush engine (shortcut F5) and check the

box next to Color Dynamics, Play with the

lers to see how they affect the brush that
you are using. | move them just a bit to the

right because | don't wanl a strong effect

03 Initial details

Keep the inside part of it a dark red. Most

of the work is done outside the wound

You can add som

highlights to the edge
of the skin to suggesl the thickness of it

Adding some darker and saturated colors
near it will indicate some trauma that the

tissue near the wound is suffering

04 Blood spatter
v

a brush with Wel Edges activated
in the Brush Presets panel to paint some

blood stains near the edge of the wound
| add some more variation to the dark
red inside the wound by color-picking it

and

Ising a brush set on Linear Dodge
(Add) mode. To change Brush mode
on the fly use the shortcut Shift+right-

click while using the Brush tool

05 Highlights and extra details

| add some specular highlights with a

default round brush and a color near to
white. | add some more detail with some
bruising. | paint bruises by setting a brush
to Multiply and picking salurated green
blue, and yellows, and painting in the

same |ayer as the skin so it blends well
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Tattoos

by Tim Léchner

01

at

wether it is a tri

2 or

a colored picture, by drawing it with full

apacity. At this point y

jou don't have lo

think about the per:

hile being on the

on a different layer to the

02 Placing th

You can g

document by

Jing th

into the w

<Spé

ce

of your paintir

the arm and size it to your liking using
the Transform tool (E

ha

it = Transfc

m > Scale

down Shift to keep the

03 Wrapping it around

For this task you need th

o Edit > Transform > Warp. h

transformation frame

tatl

a. Pull the anchor

form of it to the rol You

ick ar

he cells of the grid to

00, Hit Enter after you're done

your tattoo into

hits |

/. Now it adapts the

f the arm

w and blends into

the painting. You might want to adjust the

ave become

the original

e that

tattoo imag

nal tattoo

iment ar

> Transform = Flip Harizontal). All that

is left now is to repeat st

To see
this quick
tip used in a

final concept,
go to page
202

17



Female ears and earrings

by Tim Lochner

01 Preparations

To see

05 Additional details this quick
: 10 the = L tipused in a
- final concept,
go to page
202

Yo an ad al delails
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Female eyes and makeup

by Bram "Boce" Sels

01 The shape of the eyes

w the 5

layer lo use a gui

around tr

vy into the

ause it will h

o shade an:

02 Shading the eyeball

Another important thing

alize wher

pai

ng eyes is that you

object. Nole how the ball shap

and how it catches
top. The eye itself will be

and the eyelid will be drag

03 Eyelashes

often

188 makeup fo increase it

e of their lashes. To en ce that &

they also darken them

J

eyelids

a dark broy

around 1 to darken

everything around the lids, especia the

crevices. Note how |z

04 Maleup magic!

Makeup is easy if you have the shape and

values of the eyes blocked out correcltly. Add

layer on lop, set its blend de to

Overlay, and use your preferred color to paint

in the makeup where you want. In image 04

you can clearly see what the Ov

ay layer

looks like without the blend mode an. Dc

go overboard; 've exaggerated it for the sake

of this quick tip, but subtiety is often the key

05 Little specular lights
Because makeup is rather noisy and gritly
it's a good idea to add little specular lights

around the highlights to make the noise

l |

more convincing. Use a textured brusk

the stand:

d Chalk brush), add a new layer

top, set its blend mode to Color Dodg

and use a dark gray to dot over the

where the

yeball meets the

eyelid. Your eyes will feel polished in no time!
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Male eyes

by Carlos Cabrera

01 Notice the difference

Create a new layer and pick a small 10-pixel
brush to make a quick sketch. Paint the

skin color with a bigger brush at 50 pixels
with opacity set to 50% to blend the colors.
Paint the skin color in another layer below

the line art 1o keep the skin clean

02 Volume plane

The face is divided into planes. On a top
layer in Normal mode, paint the planes of
the face with a big round brush. Paint the
light with a yellow/bright skin color. Avoid
black for the shadows. Use the Lasso toal to
make the projected shadows over the face

03 Shadow detail

The line art is still visible with the layer on
Multiply, so change the line art color to
dark brown. With Lasso tool, “draw” the
shadows without losing the planes from
step 02. Paint with a round brush at 25
pixels and opacity set to 20% to blend
the skin color on the shadow areas. Work
on the shadows, not the highlights

04 Strong highlights

To add velume to your eye add some
lights without dulling it. Now you have the
color base for the shadows and skin tone.
move to a yellower/brighter color, keeping
it desaturated. Add a stronger highlight
on the forehead, and transparent ones to
the cheekbones, by making a selection of
the highlight areas and using the Gradient
Tool from the top (where you will have the
strong color) to the bottom of the face

05 Smudge it all

Now we have the highlights. the shadows,
and some detail we need to smudge all
the areas. With the Smudge Tool blend
the highlights and shadows to create
reglistic skin. Select a 6-pixei brush set to
50% opacity and paint the highlights on
the iris. With a smallest brush paint the

hair on the eyebrows with litlle strokes.

174

To see
this quick
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Male ears

by Alex Negrea

01 Establish the proportions

| start with lines fo establish the proportions
and the design of the object that | am
drawing. | use a default Photoshop brush. |
think about the volumes that | am about to
render: the ear is made mainly of cylindrical
pieces. The silhouette of the ear could also
be considered to be a half of a heart shape

02 Start rendering

Once | have finished the line ar, | use
selections to define the entire silhouette of
the object that | am rendering. In this case
the shape is simple so | use the Lasso tool.
Once | have the selection | fill it with a skin-
toned color and lock the transparent pixels
| start blocking in the shadows, considering
the volumes that | want to represent

03 Sub-surface scattering

The ear is a thin layer of folded cartilage
which allows light to enter the surface

and bounce inside it creating sub-surface
scallering (SSS), This means that inside your
shadow areas there will be some saturated
light. To achieve this, color-pick the existing
shadow color and, based on that, alter it

s0 it's a bit lighter and more saturated

04 Soften the surface

Because the ear is old | intentionally
leave some rough textures from my initial
brushstrokes. | use the Smudge tool o
soften the surface with a default round
brush with some Scattering. You can
experiment with the Hardness option too

05 Texture details

The older the person, the more textured and
hairy the ear. | use Bevel & Emboss with

a default round brush with Scattering for

the tiny bumps. The effect is too strong at
first so | rasterize the layer style (right-click
on the layer and Rasterize Layer Styla)

| then apply a Gaussian Blur filter on that
layer so the effect is smoather. | also add
some white hairs coming out of the ear

02
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Delicate nose

by Bram "Boco” Sels

01 The shape of the nose

As with all facial features, you should plan
ahead and lay down a sketch of what you're
painting. Look for reference and using only
a few lines, try lo construct how the nose fits
on the face. Keep your lines on a separate
layer so you can still turn them off later

02 Construction

When painting a complex shape it's often
better to start out by dividing it into fial blocks
and planes. Study how the bridge of the nose
moves inward around the brow and jumps
forward at the tip. This is especially true for
young noses and is a big part of whal makes
kids and teens look sweet and innocent

03 Blending the planes together
Once you've constructed the planes of the
nose il's an easy task to blend them together
and smooth them oul. You can do this by
either using a big soft brush to go over each
cormer or by selecting the Smudge Tool 1o
push the pixels into each other, Don't worry
aboul the noise and freckles you're losing,
you can add them quickly again later.

04 Lines versus edges

Now it's time 1o turn off the line drawing and
focus on the edges. The difference is that
lines don't actually occur in nature, so you
have to find a way to paint the transition
between light and dark without using a
hard line. Note that wherever a crevice
occurs (such as beneath the nostrils), the
shadows are darker and the edges sharper.

05 Detailing

Keep on working on those edges, but
don't forget the large shapes. The tip of
a small, young nose is often round and
should be shaded accordingly. Look at
how part of that round tip catches light,

while the other side is much darker. You
can alse reconstruct the freckles around
the bridge of the nose and paint in that
small, fun highlight on the tip of the nose.
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Thin lips

by Romana Kendelic

form

farm, gently curving lines and
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Voluptuous pout

by Tim Lochner

01 The simplified drawi
Before | put color and rendering into the lips
it's important to have a simplified drawing

which describes the design of the mouth and
gives iLits proportior

and shape. You don't
have to outline every detail, just the most

important parts: the opening line of the mouth

and some indications for the upper and low
lip. Don't draw the opening line too strong
it's only important to add the middle contact
point of the lips and the mouth comers

02 Adding rougt -
Use a large, normal round brush with 0°

Hardness to fill in the basic light and sha

colors. Don't worry if you go aver lines
it looks more natural if the lips aren’t
completely separated from the skin around
the mouth. Reduce the opacity of the line
an layer beforehand. | usually base my lip
colors on the character’s skin tone and add

mare saturalion and red to it. A stro

03 Detailin
I mainly use a brush with hard edges and

the Opacily Jitter set on Pen Pressure

Use it to add details like very sublle folds
in the shadows and small light strokes
for the highlights on the lit side.

04 Hard ed

The separation of the upper and the lower

lip is important. Use the freehand Lasso

tool and select the upper edge of the mouth
opening. Add a darker value with a small
round brush with 0% Hardness. To increase
this effect you can invert your Lasso seleclion
and add a lighter value to the lower lip so the
dark edge of the upper lip touches the part

of the lower lip, which is a little bit brighter

tipusedina
05 r final concept,
To give it a more painted and realistic go to page

look, | erased the lines of the drawing. | 202

suggest adding a layer mask, which you

can find at the bottom of the Layers panel




Male nose

by Alex Negrea

01 Rough line drawing

Here | stari a rough line block-in. It's rougher
because from this angle the only things that
overlap enough to see form transition are
ihe nostrils and the skin of the cheeks, which
doesn't allow us to see all the nose parls.
So | add some lines even though | don't see
them (for example the bridge of the nose).

02 Lay down the first colors

To get some nice skin tones | activate the
Color Dynamics on the brush that | am
using. This creates variety in the values
of the initial color you are using. | also
paint the shadows inside the folds, even
though they overlap with the line art at this
point. This allows me to have that shadow
already in, and nol worry about it later,

03 Render the forms

The shapes of the nose are made of
spherical and cylindrical volumes, Roughly
knowing those shapes in your head

will make it easy for you when it comes

to rendering. To make the shadows
deeper | use a brush set to Multiply.

04 Add in texture

Because my shadows were already too dark
and because | am painting skin, | have to
think about sub-surface scattering. | lighten
them using a brush set to Lighten and with
a color that is more saturated and lighter

in value than the shadow. To add texture |
use a default round brush with Scattering
turned on to creale all those tiny speckles
without spending too much time on them.

05 Final details

To make the skin older | continue to
add more speckles and imperfections
to it. Because this is an old person’s
nose, | add some white hairs inside the
nose to further push this feeling.
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Mouth and teeth

by Alex Negrea

01 Line art

| start with line art to help me pre-visualize
the subject that | am about to render. Having
the teeth drawn out before the rendering is
a huge help. The teeth marked with blue are
flatter than the rest. That means that when |
render themn | will treat them like a box and
not as a cylinder (like the rest of the teeth)

02 Block in the colors

| use the lines lo do a clean selection using
the Lasso tool so that later on when | need
to paint on them, | don't worry about their
edges. Once | make the selection | create
a new layer and fill it with the foreground
color and lock the transparent pixels

03 Render out the values

| use a soft round brush to paint everything in
this stage. | set it on Multiply for the interior of
the mouth $0 | can paint some darker values
| keep the colors saturated and close to
reddish and orange-ish colors. | pay attention
to the volumes | want to render. The lips are
like cylinders that wrap around the mouth
and the tongue is like a stretched sphere.

04 Paint the teeth

Even though teeth are solid they allow
small amounts of light to pass through
them. That means a sub-surface scattering
effect is going to be visible. Meaning that
parts of the transition edge of the shadows
will be more saturated and lighter in

value than the shadow. | iry o remember
this so | don't destroy that saturation.

05 Specular light and depth

| leave the specular lights for the last part
of the drawing. They add the glossy feel
of the teeth and the other wet surfaces
like the tongue or the lips. Note how |
keep the interior side of the mouth edges
very soft to push the idea that it’s a soft
material and not hard like the teeth. It
also adds depth, making the teeth appear
more forward than the rest of the mouth
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Fur

by Romana Kendelic

01 Types of fur

There are many differant types of fur, not
just in color or length but the texture, too
There is bristly, woolly, soft and plushy

silky, tangled, and so on. Also lols of
animals have layered fur. a softer undercoat
(downy hair) and a coarser top layer (guard
hair). This top layer is usually strongly
pigmented including a whaole range of

patterns (for example as seen on big cats)

02 Basic shapes

| block out shapes with a soft brush. Start
with the placement of light and shadow. Paint
in the basic color and tone, and pattern if
any. Fur of some lengths naturally clumps
together and this is what you should paint
thick sections that overlap and separate. Use
loose brushsirokes and leave all detailing for
later. Keep in mind that fur has depth and
weight. Paint in the direction of the growth

03 Clumps of fur

Define the edges of the clumps of fur. Check
a reference to see how they move — is it soft
fur with gentle curves, or coarse and bristly
which would benefit from sharper, straighter
lines? Instead of rendering every individual
hair you are trying to give an illusion of detail

04 Details

Refine the fur. Start by adding more
defined highlights and shadows, Do not
lose the clumps; just add more definition
to them. There may be cast shadows

ta darken, or overlaps to highlight. If

the fur is not the focal point of your

painting you can safely stop here

05 Guard hair

Finally add the guard hairs. Usually they are
coarser single hairs protruding through the
coal. Use a hard-edged brush on a separale
layer. Sharpen filters may help separate

the soft undercoat from the firmer top layer
(Filter > Sharpen). Il the fur is glossy, now
would be the right time to add highlights

To see
this quick
tipusedin a

final concept,
go to page
0
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Lace

by Bram "Boco” Sels

01 Dressing up

When painting translucent materials such as
lace, the background they're draped over is
what makes them convincing, as it shows
off the transparent parts. In this quick tip

we start with a pair of legs which we'll soon
dress up with a fantastic-looking lace skirt

02 The base of the skirt

Start out by painting a convincing base
without worrying about the details. In this
case | went for an opaque white skirt; you
can change the base color to whatever
color you want. Keep in mind that the
shape of the skirt should wrap around
the legs as convincingly as possible

03 Opacity

Mext, duplicate the layar then hide the back
layer and select the top layer. Al the bottom
of the Layers palette click Add Layer Mask
and press Cirl+l to invert the layer mask
Notice the skirt disappears — this is because
your layer mask is now empty (black). If you
now select the layer mask (click the black
rectangle next to the layer’s thumbnail) and
paint in that mask with a white brush, your
layer will show through wherever you paint.
Finally, unhide the second skirt layer and set
its opacity to 50% to get a see-through skirt.

04 Painting in the lace pattern
Select the upper skirt layer (which is still
invisible due to the black mask), click
on the layer mask (the black rectangle),
change your foreground color to white
and you can now use a regular brush

to paint in the lace pattern. Everywhere
you paint in the layer mask, the opaque
top skirt will appear in your canvas

05 An extra detail layer

Finally, create an extra layer on top of the
others and paint in the rest of the details
Don't do Ihis in the masked layer, as lace
patterns lend to be bumpy and uneven, while
the masked layer is clean and straight
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Leather

by Bram "Boco” Sels

01

yur backg

ound layer w

al o and use a big brush to

the

general direct

with a top | s0 lighter bro

while the outs

02

Add a n

layer, fill it

white and

a dark brown foreground colar

Filter Gallery > Texture

ar texture. Now use Filter >
S¢

Accented Edges to get rid of the

sallery > Brush Stroke

03 Bevel

th the wt

texture I

k on Chani

Ctri+click on the
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everything
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e Layers lab, click on the b
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3
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%
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1o copy/pas

Hide the top white layer and

on the new layer. You'll see the Layer

Sty

window - click on Bevel & Emboss

This will mal

with a nice high

to Multiply to accent the

crevices of the leather, The pattern is rather

horizontal, so sel both your Multiply layer

and the Bevel & E

35S layer and rolate
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to fill the empty s
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Silk

by Bram "Boco" Sels

01 Local color, light color

it Choose the c

(local color), and the color o
the environment (light color n this case

the silk is red and the

the highlights of the silk will be pu

pink {red mixed

will turn out (o be

high

each other. For e

the previous st

for the h he sharper

sharper the highlight on it, so in places

2 the silk takes sha

05 Texture
Although silk feels sme

sxture and r

) get this textt
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Jewelry

by Romana Kendelic

01 Sketch

Start

ith the ske not have to

articularly Ailed; an accurate outline

with placement

JES! st shadows wil

be fine. Try to find a pleasing compaosition

02 Blocking in

r o Multif

and start ¢

e light source and how the value

the forms. There

0N e:

further away. Establisk

one and one

midlones, core shadows, and

on the spherical gems. On the cut

the sides that are light and ones that are

dark. Le:

ning 10 § basic shapes is

an essenlial par ¢ aling a successful

onof 3D a ts on a 2D canvas

03 Developing the forms

Lower the opacity on the sketch layer and

als act. The

on the ring is semitre

1spar

see ho

light enters the gem from the right and above

then pools on the opposite end. The

that

shines through takes tt

gem sphel

do not trans

the light. The

is colored due 1o the n surface
04 Metal

Turn off the line |

the

vires in the earrings)

See how hues shift from slightly greenish to a

range of ock

ers to yellow h

Jhts. Dz

the shadows nirast is the key here

05 Highlights

it well-placed reflections and

highlights. The harder and smoother the

reflective it is. Pick the

ite, and with a

1sh pinpoint your highlights

Multiphy w  Opatity:
Lock: ] v+ @ Fill:

To see

this quick
tipusedina
final concept,
go to page
204
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Weapons

by Carlos Cabrera

01 Don'tlc

Draw everything in one layer (line art layer)

e the shape and line

Create another layer below this, Make a
quick selection with the Lasso tool, fill with

the Paint Bucket tool, and using the same

selection apply a gradient to create light
and shadow. Change the layer mode to

Multiply to see the line over our base layer

02 Simplify with boxes

When painting the light and dark areas
simplify the shape. You can do this in another
layer. The strongest lights are followed by a
darker shade to give a flat and deep feeling
1o the shape. Use the Polygonal Lasso
selection ool to create the faces and the

Paint Bucket toal to fill them with gray colors

03 Add detail to the object

Using the Brush tool and a brighter color
than the base. paint the weapon with an
almost white color to achieve a metallic
feeling; note where metal reflects light. Paint
soft shadows on the holster to emulate

the fabric. Use the Dodge tool to add

the highlights and create softer lights

04 Colors

Add a new layer in Color blending mode
and paint with a desaturated blue. Pick
a green and paint only the shadow side
of the weapon and halster. In a new
layer set to Normal mode, paint where
the highlights will be with a round brush
at 20 pixels. Smaoth out the light and

shadows

xn the gun to make it realistic

05 More de
Add conltrast to color to create better

ail and realism

volume. Soften the fabric with the Smudge
tool to create a realistic texture. With a
10-pixel round brush, paint highlights on
the metal and blend the reflections. Add
saturation lo the shadow area with a layer

set to Overlay. Add small details, like

se s and creases with a small 2-5-pixel

round brush set to 100% opacity
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Glasses

by Bram "Boco” Sels

01 Designing the glasss

The selling power of your image

mes from

the design of the glasses. In this case | w

for an old model that sits on the nose

staried out b

ealing two separale layers

for it; one with a dark color for the frames

and one with a gray color for the glass

02 De

Once you have both layers you can decide

1g on the color

what material your glasses will be made of

The giass itself is easy to do, just put the

layer's opacity to 20% (or more if you

thicker glass), and that's it. The fram,

bit more difficult, but to begin we'll d

the color we want. | give them a gol

kind of color by pressing Ctri+U and fidd

around with the sliders until | am satis

03 Bevel &

For shapes that are thin and small like this

one. Bevel & Emboss can get you started
really quickly. Double-click on your frames
layer in the Layers palette, choose Bevel

& Emboss in the pop-up, and chang

colors of the highlights and shadows
while and black to browner colors. Hit OK

and right-click on the layer to Rasterize Layer

Style. This merges the effect into the layer

04 Hi

sl & Emboss can only get you so far

though. It's a digital effect and therefore
looks like one, so it helps to go back in and
manually paint over the effect. Also think
ahout where the light is coming from (in my

case from the top-left) and accent the frames

with some bright h hts in that direction

05 Cast sh

To make your glasses even more convinging

paint in the cast shadow it leaves on

the face. It helps to ground the glasses
on the nose and makes it all the more
convincing. Finally you can also add some
little scratches and bumps to the model

o make it a little more worn and used
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Breakdown gallery

Find inspiration for your own creations
with a gallery of diverse characters.

In this section you will discover a stunning gallery by a
selection of lalented artists, which will also uncover the
visual progression of each image as they reveal the steps
behind their process. This will enable you to understand how
different elements covered in this book can be combined and
built upon to produce a top-quality character painting




Subterranean man

by Chase Toole







Alchemist

by Andrei Pervukhin
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Femme fatale
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Warrior elf

by YongSub Nch







Bio-mechanoid

by Gerhard Mozsi







Sci-fi soldier

by Carlos Cobrera
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Regal old man







Moonshine villain

by Charlie Bowater
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The socialite

by Devon Cady-Lee
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Glossary

Adjustments layer palette

Above the Layers palette (if it's missing

go to Window > Adjustments) you'll find

the Adjustments layer palette. Each of

the buttons here quickly creates a new
adjustment layer on top of the layer you have
selected. What an adjustment layer does

is change the way all the layers below it
look. You have adjustment layers to change

Background

The Background layer is the bottom layer of
the layer stack. I's partially locked because
you can't put anything below it and it can't be
directly edited either. It is always at the very

Blur

Blurring is a technique that's mostly used to
reduce details and noise in an image or layer.
In Photoshop there are typically two ways a
blur can be applied: the first, via Filter > Blur
(Gaussian Blur being the most notable here);
the second via the Blur tool, found in the tool

Bounding box
The bounding box is an invisible box that
holds the content of a layer. You can easily
turn it visible by clicking on the Select tool
and checking the Show Transform Controls
box. Now your layer will be surrounded by
its bounding box. The Transform Controls
on the side of the box can be used to
quickly rotate and resize the bounding box,
simultaneously rotating and resizing what's
in it as well (see Re

ate and Scale)

210

brightness, contrast, levels, hues, colors,
and so on. The benefit of using these layers
is that you quickly tweak your image without

aclually changing the informalion in the

layers below. Ir er words, you can always

go back and change or delete the adjustment

o Fd = [X] (W

layer later if you're not happy with the results

bottomn of the image and fills up the entire
canvas (see Canvas). It functions as the

foundation on w

h you build your image

every new layer will be “built” on top of it

bar under Smudge. While the first applies an
equal blur to the entire layer, the latter can Blusafiect
be used as a brush in different places. Mate
that once you apply a blur it's irreversible,

s0 it's a good idea o always keep a backup

layer before you starl blurring away.




Brush tool

The Brush tool can be used to paint lines,
shapes, and textures in any color. It's
important to set your brushes up in a way
you're comfortable with. Something that can

help you tw

k the brushes to your liking
is Shape Dynamics. Shape Dynamics can
help you mimic real-life brushes by allering

the brush settings (see image). Putting the

control of the Size Jitter to Pen Pressure

mimics the effect of a

paintbrush, When
you press hard on your stylus a lot of "paint
will appear on the paper and when you
press lightly only a little will appear. This

option is great when doing line art, but

when filling larger areas and you wan! y

work to have a traditional textured look

Burn/Dodge tools

The Burn/Dodge tools are basically brushes
but instead of laying down paint they darken
or lighten the paint that's already there. This
is really helpful when you want to darken

or lighten a specific area rather than the
entire image. Two important settings to keep
in mind here are Range and Exposure
Range let's you pick what it is you want to
darken or lighten and Exposure how hard
you want to change it. Say for instance

that the darkest tones of the shadows in
your painting are too bright: select the Burn
tool, set its range to Shadows and quickly
brush over the shadows you want 10 boost
IVl quickly darken it up while leaving the
mid-toned and highlight parts of it intact

Canvas

The Canvas, much like a traditional painting
canvas, is the surface you work on. The
Canvas has nothing to do with the resolution
of the image (see Resolution), but is merely
a guide to show you where your painting
begins and where it ends. Unlike a real
canvas, you can easily increase your canvas

size while working via Image > Canvas Size

.
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Clone Stamp tool

A greal way lo duplicale patterns. textures

G ushstrokes is with the Clone Stamp tool

If yo

Current & Ba

Al Lavers

s hold Alt with the C Stamp loc

selac you'll notice the cursor chang

cross. I you now click anywhere

on your image that spot will become the

arting nt for the duplication. Release

Alt and now you can “paint” with the part

2 jusl selected. Another useful trick

ange in the top bar to

& sample

rrent Layer, which will keep your clone

estricted o what's in that layer. It's a cool

silhouettes and edges

Color adjustment layers

The fjustment layers Hue/

Satura or Balance, and Selective

mainly used to change

the color of the under

g layers

Hue/Satura! e option to slide

the entire color scale of the layer al once

salurate and desatl

and also lets y

Color Ba & is a bit diffe

nt. since instead

of changing the entire color scale at once

u hone in on a specific range and

st that range. Say for instance

that you feel your shadows are too cold

s as your tone and move and lets you pick a specific
=Blue sl towa and change just that color. Feel your Greens
yan-Red slider towards red. In no aren't lush enough? Just select Green
2 your shadows will feel a lot warmer. under colors and weak it from there

Color mode Image Layer Type S Filter 3D View Window H
Simply pul, the Color mode is the method [ S
1 which the pixels in your image are Grayscale
n whi @ pixels in your image Adjustments » )"
Stand inters only have four
-+ Ctrl+ exe
erent inks: cyan, magenta, yellow, and Auto Tone Shift+ Cerl+L
A &+ Shifts Ctri=L
black (CMYK) and they creale different e e £ 3 RGE Color
. t ft= Ctris v CMYK Color
ombining those four inks. So in Lab Col
ab Coler
hop yi n organize your image Image Size. Alt+Ctris]
. 3 i Muitichannel
ter knows how mu Canvas Size... Alt+Ctrd+C
Image Rotation * v 8 Bits/Channel
16 Bits/Channel
Trim... t 3
Reveal All
r mode comes in
A good rule of thumb is when your image Duplicate.
will RGB and Apply Image...
when it pr i use CMYK Calculations...
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Contrast

Brightress/Cont

ands the

ight and dark. Increa: Brightness: ] L__OK
r image P
g N Cancel
ker and light parts even Contrast: 0
Auto

g the contrast will do the

Use Legacy < Preview

Revesl & :
Caler Lookup
wplicate

Agply

age

Calculation

Crop the mage?

Giop Don't Crop

canvas, clearing up

1as a result

making a layer look

r, 50 Us

them with caution and keep a backup

Flatten

zans all your

are combined and merged into the
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Gaussian Blur

Gaussian Blur (Filter > Blur > Gaussian
Blur) is an easy-lo-use filter that blurs your
selected layer It's a great tool to virtually
creale depth of field. Remember, blurring
a layer is irreversible so use it carefully;
Gaussian Blur is a filter. which means it's
a digital calculation and will therefore look
digital - if you want a realistictraditional feel

it's best to create the effect without a filter. It's

a useful tool in a preduction pipeline where

things need o go quickly and efficiently

Gradient tool

The Gradient tool, much like the Paint
Bucket tool (which will fill an area around
the pixel you clicked with your selected
color), either fills the entire layer or just

the part you've got selected, and creates a

gradual blend between two or more colors
The standard gradient consists of the two
colors you've selected as foreground and

background colors, so you can quickly

create new gradients by using the C

Grayscale

Grayscale is a Color mode (see Color
mode) that turns your entire image 1o black
and white, deleting all color information but
making your file size much smaller. What's

Highlights/shadows

Each image can be turned to black and white
and seen as a combination of different values
(see Grayscale). It is in these values thal we
find the highlights and shadows. Everything
that's dark can be considered shadow, and
everything light a highlight (in between are
midtones). In Photoshop these terms are
used to let you know where the effects are
applied - if you use Color Balance, you can
change the lone to shadows and only apply

the effect to the darker parts of the image

214
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Harme.

Foreground to Bicugrowns

Grdwrt Type: Sold -

Picker. Alternatively you can also click on
the gradient in the options bar on top o

important to know about Grayscale is that

the Histogram is based on it, and it's a scale

that consists of 256 different values, ranging

fram black {being value 0) and white (being

Shadows
Amount: H %
Tonal Width: 50 %
Radus: 30 px
Highlights
Amount: 1] %
Tonal Width: 50 %

E

open the Gradient Editor and to manually
modify it to blend more or different colors

value 256). Every type of gray can be found

between those two values. The same sc

e
Is used by other Color mades too, but there

each value also has a color applied to it

Radus: 0 px
Adjustments

Color Correction; +20

Midtone Contrast: o

Black Clp: 0.01 %

White Cip: 0.01 %

Save As Defauls

# Show More Options




Histogram
The Histogram gives you an overview of the

values in your image. You can find it under

Window > Histogram. It's an especially useful

tool to keep your values in check. From left
to right it shows how your values are divided
On the left are the dark values, on the right
are the light. In the extended view you can
also see the values for each separate color
channel. When using the Histogram there
are a few things 1o consider. Is the flow of
the graph more or less fluent? If there are
big spikes. there's probably a value that's
too prominent and should be broken up into
a few more subtle values. Another thing to

keep in mind is that your values should stay

Keyboard Shortcuts (Actions)
Keyboard Shartcuts work in the same way
as Actions (see pages 18-19in the first
chapter of this book). Using Keyboard
Shortculs efficiently can save you a lot

of time. When you get comfortable with a
working method you'll notice that you often
repeat the same sleps over and over and
in that case it pays to have a shortcut for
it. Click on Edit > Keyboard Shortculs and
here you can change the way you access

mast of the tools found in Photoshop

Lasso tool

Getling sharp edges becomes easy when
you use the Lasso tool. Simply select part
of your image using the tool, create a new

layer, fill it with a color and click on Lock

Transparent Pixels (see Layers palette) and

you'll have a sharp silhouette, which you can

fill with whatever you want. There are two
important Lassos: the basic Lasso. and the
Polygonal Lasso, which does the same but
with straight lines. You can quickly alternate
betweaen the two by pressing AlL. It lakes a

bit of practice, but it absolutely pays off!

Navigat Histogram

Channel: | Colors:

P ok
Cache Lovel:

away from the absolute left and absolute
right = those values are pure black and

puri

and they have the tendency

lo create L and dull looking images.

Vaypmed Shorm  them

Sat Phozsshon Defauss (mechee v Gancel

Shortcuts FOr:  Appicaton Manus = /U Legacy Crannal Shomouts

Apphcation Meny Command Shortcut
b Al
- Edt
Undo/Rede a2
Shifts Cerl2
LheCliiel
Shifts CarlF
Cut QirleX Sumrrage..
F2
Copv Q=L =
ird shortcuts:
% New Set button to Create 3 copy of th selected sat. or select & sat to moddy

hameut” columin for & comi
N you are done editing to s

press the keyboand shomcut to assign
all your changes
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Layers palette

The Layers palelte is your friend! Il's ane of here is the Lock Transparent Pixels button
the most important features Photoshop has at the top. You can quickly toggle it 1o lock
to offer so iry to make good use of it. The everything in the layer you haven't painted

basics are simple: think of layers as stacks of  on and

f you paint on the layer now it will

paper, if you cut a hole in the top paper the only change the paris that have pixels in

paper below becomes visible. The Layers er useful buttons are at the bottom

palette is a visual representation of that stack  Drag and drop layers on the

to respectively

of paper. One of the most important buttons create a folder, ¢

plicate, or delete them

Liquity Untitied§ &

Liquify
T

and deform your sele

> Liquify

ted areas as if they

were wel paint. You can find this option in
Filter > Liquify where a separate preview o e e T
window will appear, so you can view the Buheman 10 v

off
ef

before you make them permanent

Occlusion shadow

Occlusion
shadow

M OCCUrS

ere the main she meets the cast

shad

w and it is usually very dark

Opacity
Each I

er (see Layers palette) in your layer

slack can differ in opacity. Basically. opacity

is expressed in %) tells you how opaque

r with 100° Jacily Is a

see lhrough, so every
lely hide the pixels

and that pixel will show

50% of itself as well as 50% of what's below.
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Patterns

When you double-click on a layer in the
Layers paletie, the Layer Style window will
open. In it you'll find the Pattern Overlay
option, which is used to fill the entire

layer with a pattern. You can use these

palterns to give your image a texture by
changing the Blend Mode of the pattern
to Overlay, Soft Light, or Multiply.

Creating your own patterns is also easy.
Simply open up an image from which you'd
like to create a pattern and click on Edit >
Define Paltern. You'll now find your new
pattern in the Layer Style window. Tile-
able images work best for this since they'll
seamlessly flow over into each other. On
sites such as http:// freetextures.3dtotal.
com and www.cgtextures.com you can

downioad tons of tile-able patterns for free

Resize
R\'_‘S\Zlﬂg your image means you e her
decrease or increase it in size. Which of the

two you do is imporiant though, because in

the case of the first you'll ask Photoshop to

use the pixels you have to make the image

Resolution

For a lot of people the resolution is a
complicated concept because they often
confuse it with the resolution of their screen
But think about it like this: an image of

10 = 10 pixels in Photoshop (that's not

zoomed in or out) will exactly use 10 = 10

Rotate

Rolate is used to literally rotate the layer
you've got selected. By uming on the
Transform Controls {see Bounding
box) and hovering your cursor over

the corner of a layer, you will see

that it changes into a bent arrow

Dvwrlay

Graent Cvery

smaller, which is usually not a problem, but
in the case of the latter you'll ask it to space
out the pixels you have and “invent” the open
spots that'll turn up between them. Increasing
the image size is usually not a good idea

pixels of your screen, regardless of how
high the resolution of the file is. Why are
there different options there then? Other
hardware, such as a printer, does not know
what pixels are. So in your file you can

include information as to how it should deal

With it you can turn a layer 360 degrees
around to whatever position you want. This
is useful when you've got different abjects
on different layers and you feel some of
the objects lack dynamism or don't feel

like: they fit right in the composition

Cancel

Naw Style

¥ Preview

because you'll end up with a blurry image

as the pixels become more spread out. It's
always beller lo start out big and resize

your image later, than to do the reverse.

with those pixels. “ppi” stands for pixels per
inch, and simply tells your printer how many
pixels it should print on 1 inch of paper

The rule of thumb here is that images for
print should have a resolution of 300 ppi

Images for web have enough with 72 ppi
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Scale

Scale is another word to describe the
size a layer has in your image. In other
words, how big it is compared to the other

Selection

A selection in Photoshop is immediately
recognizable by the "marching ants”
surrounding it (moving dashed lines)

It's an important feature in Photoshop
because what you've got selected is the
only part of the image or layer that will be

Sharpen

Sharpen is a filter that locates the edges in
your image and then increases the contrast
(see Contrast) around them. making them
appear more defined and crisp. The most
reqularly used Sharpen is the Unsharp
Mask, which you can find under Filter >
Sharpen > Unsharp Mask, but you can also
use the Sharpen tool the same way you'd

Smudge tool

The Smudge tool does exaclly what the little
icon shows: it pushes your paint around

It's like putting your finger in wet paint

and smearing it around. It might sound a

bit messy, but it's a useful tool for several
reasons. First and most important, it helps
you 1o be able to generate different types

Swatches

It's a good idea to keep a collection of
swalches. Sites like http:/icolor.adobe.
com can help you find and save the
perfect colors for your work (there's also a
separate palette for that site built directly into
Photoshop under Window > Extensions >
Kuler). If you have a color selected, simply
open up the Color Picker (by clicking on
the color in the Tools palette) and click

on Add to Swatches, You'll now find your
new color in your Swatches palette. Look

218

layers. You can quickly change the scale the control points that pop up. Quick tip

of a layer by tuming on the Transform holding Shift while dragging on the corners

Controls (see Bounding box) and dragging keeps the proportions of the layer intact.

affected when you work in it. Selections
can be tweaked and modified by right
clicking in them and clicking Refine Edge
By doing this you can see exaclly what
you've gol selected and change how soft
or smooth the edges of that selection are

use the Blur tool (see Blur). You might be
tempted fo think of it as a way to reverse
blurring, but nothing is more wrong. Blurring
is a way 1o reduce delails and noise, but
Sharpen can never reinvent all that lost
detail; instead it will result in an image
that's blurred, but with very high conlrast

of edges - instead of having only straight
sharp edges, some of your edges could

be blurry and blend with the background
Second, when you are painting materials
thal have a smooth surface, it helps you to
blur the surface without losing that painterly
feeling which you may be looking to achieve

for color palettes consisting of five colors
that fit well together and then add a black
Swatch to separate it from the next five
You'll then have quick and easy access

to a few super solid color combinations




Value adjustment layers

The first three adjustment layer options
are your go-to layers lo change the values
of your image. Brightness/Contrast is by
far the simplest, and provides you with
just two sliders that you can use to adjust
he lonal range of the image. The Levels
sanef shows a histogram for the image

On the left you see the dark values and on

the right the light values. With the

you ¢a ¢ part of

n easily change a speci

the valu

ithout touching the values

you're happy with. The Curves pal s the

mosl complicated, but it does the same as

Levels (it's more expansive if you want to

micromanage your values). It she

you

the same histogram, but instead of usi

sliders it uses a curve to alter the values

Vignettes

Vignettes have been used in the photography of the image. towards what set its blend mode to Multiply and go to

and film industry for decades It's a technique  is important. In Photoshop a quick way Filter > Lens Correction. Then just click on
in which the periphery of an image is to do this ate a new layer on lop Custom where you can change the Vignette
darkened, which helps to guide the focus of the layer stack, fill it with white, then slider; moving it to -100 works well

Warp tool
Sometimes a shape just doesn't feel 100%
right and needs to be altered a little to fit

In that case the Warp tool is the way to go

You can find it under Edit > Transform >

Warp. What the Warp tool does is cover your
layer with a grid that has 16 anchor points

in it. You can drag and move each of those
points to transform the layer exactly how you
want it. Alernatively. in the same menu you

can also find Distort and Perspective, two

other greal ways to manipulate your layers

Zoom
The Zoom function is another great (like traditional painters used to do}, you can but the most commonly used is the wheel
Photoshop feature. Instead of having to have Photoshop do it for you. There are a of a Wacom tablet, or by pressing Ctrl and
move back from and forward to your canvas few

ABYS 1o zoom in or out in Photoshop, + to 200m in, or Ctrl and - to zoom out
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beginner's guide to digital painting in Photoshop:

Beginner's Guide to Digital Painting: Characters is a comprehensive guide
for artists wishing to create convincing and detailed characters. It features
eslablished artists such as Charlie Bowater (concept artist at Atomhawk)
and Derek Stenning (freelance concept artist and illustrator, with clients
including Marvel Entertainment and Nintendo) who share their industry
experiences by covering such aspecis as posing characters, choosing

the comrect costumes, conveying emotions, and creating suitable moods.

Comprehensive step-by-step instructions — including a quick tips section that
covers how to paint elements that are integral to character design — make
this an invaluable resource for those looking to learn new skills, as well as

those pursuing the next level,

“These tutonials not only provide interesting
exercises for the beginner to help build a strong
foundation for drawing and painting, but also provide
important insights into the mindset of a concept
artist. Very useful and inspiring!”

Digital concept artist & animalor | loig




